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1. Installation Guide 

1.1. System Assembly 

Double-click the installation package to open the Software Installation Wizard. Close all other 

applications before proceeding. 

Click Next to open the installation path selection window. You can click Browse to choose a 

suitable installation path or use the default path without modification. The window will prompt 

that at least 220.4 MB of free disk space is required. 

Click Next to start the installation. The progress will be displayed in the window. 

After the installation progress bar completes, the installation completion window will appear. The 

software is now installed, and a shortcut has been automatically created on your desktop. Click the 

End button to close the installation wizard window. 

1.2. System Start-up 

Start the program from a desktop shortcut or the Start menu. 

1.3. System Requirements 

The AcuteLas Studio software is compatible with Windows 7, 8, 10, and other operating systems. 

1.4. Exit the System 

Click the close button in the upper right corner of the software to close it. If an engineering file is 

open, the system will close the file as well. 
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2. Operation Interface 

The software interface is shown below: 

 

The main interface of the software includes Quick Access Toolbar, Function Menu Panel, Data 

Display Panel, Project Manager, Log Window, etc. 

2.1. Switch Themes and Mode 

The software interface offers two display modes (dark and light) in the upper right corner, allowing 

users to switch between them based on personal preference. 

In the upper right corner of the software interface, users can select from three modes: mobile 

measurement, station scanning, and analysis application modules. These modes are available for 

different devices to preprocess collected data. 

2.2. Function Menu Panel 

The function menu panel is located at the top of the software's main interface, organizing 

command buttons in an Office-style' function group 'layout. For example, the' File 'tab includes 

functions such as' New Project ',' Open Project ',' Save Project ',' Close Project ',' Import Point 

Cloud ', and' Export Point Cloud'. 

 

For the functions and usage of each operation, please refer to the relevant sections. 
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When hovering over a button in the function menu panel, the software displays a label with its 

description. 

2.3. Toolbar 

The software toolbar includes the View and Projection toolbars and the Rendering Mode toolbar, 

located on the left side of the Layer panel. You can select and hold the left mouse button to drag 

these toolbars, or right-click in the empty area of the menu to activate or hide them. 

 

2.4. Windows 

The software includes the following windows: Layer Manager, Command Window, Preprocessing 

Manager, Start Page, and View Panel. You can right-click on any blank area in the menu area to 

activate these windows. 

2.4.1. Layers Manager 

The layer manager is used to control the visibility of each layer in the view window. There are 4 

layer types: point cloud, vector, raster, and model. 
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The point cloud layer manages imported point cloud data. Right-clicking the layer displays a 

context menu with options like 'Import Point Cloud Data,'  'Remove All,'  'Show All,' and 'Export 

Point Cloud.' Right-clicking the sub-node reveals additional functions: 'Show Point Cloud,'  'Hide 

Point Cloud,'  'Remove Point Cloud,'  'Plan View,'  'Set as Base Station,'  'Set World 

Coordinate,'  'Zoom To,'  'Open File Path,'  'Export Point Cloud,' and 'View Properties.' 

 

2.4.2. View Window 

A view window for visualizing imported data. Supports creating multiple views to help users 

organize data intuitively, such as browsing, editing, and measuring point clouds. 

2.4.3. Command Shell 

The software supports command-driven functionality. The command window is used to accept 

commands, receive interactive parameters, display execution status, and provide real-time 

feedback and logs. 
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3. SLAM Mode 

3.1. Pure SLAM Solution 

1.Select SLAM Measurement Mode – Handheld Solution. 

 

2.Select the file to load, choose Pure SLAM Solution, then click Next to start the solution. 
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3. Any calculation exceptions will be displayed in the Details section. Once the calculation is 

complete, click Exit to close. 

 

4.After the calculation is completed, you can find the resolved LAS data in the las folder under the 

data path. As shown in the screenshot, the full path is: 

(This PC) > (E:) (Local Disk (E:)) > TEST DATA > slam > 2025-08-29_11-03-43 > las 
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3.2. Calculation Using Control Points 

1.Select SLAM Measurement Mode – Handheld Solution. 

 

2.Select the file to load. The Pro version will automatically detect whether there is a control point 

file in the project directory. If available, it will automatically load the timestamped CSV file and 

switch to control point solution mode. Double-click the coordinate column to enter control point 

coordinates. 

 

3.Alternatively, you can import survey points via the Import Control Point Coordinates function. 

The software will automatically match them by point name. Please ensure the point names of the 

control point coordinates are consistent with those entered during field SLAM acquisition.  
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Note: The Import Control Point File function is used to import control point files with timestamps, 

while the Import Control Point Coordinates function is used to import measured control point 

coordinate files.  

In the Coordinate System Definition section, you can select the coordinate system used during 

control point acquisition to define the coordinate system for the point cloud. 

Note: This step only defines the coordinate system for the point cloud and does not perform 

coordinate conversion. The defined coordinate system can be viewed here. 
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Calculation exceptions will be shown in the Details section. 

Once calculation is complete, the LAS data will load automatically. Click Exit to finish. 
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After the calculation is completed, you can find the generated LAS data in the las folder under the 

data path. As shown in the screenshot, the full path is: 

 (This PC) > (E:) (Local Disk (E:)) > TEST DATA > kzd > 2025-08-29_11-03-43 > las 

 

3.3.  Solution Using RTK Mode 

 Select SLAM Measurement Mode – Handheld Solution. 
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 Select the file to load, choose Real-time High-precision Solution – Import Trajectory, then select 

the RTK file generated by SurvStar or Zhixiang. 

 

In the Coordinate System Definition section, select the coordinate system used for RTK data 

acquisition to define the coordinate system for the point cloud. 

Note: This only defines the coordinate system for the point cloud and does not perform coordinate 

conversion. The defined coordinate system can be viewed here. 
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Calculation exceptions will be displayed in Details. 

Once the solution is completed, the LAS data will load automatically. Click Exit to finish. 
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After the solution is completed, you can find the generated LAS data in the las folder under the 

data path. As shown in the screenshot, the full path is: 

(This PC) > (E:) (Local Disk (E:)) > TEST DATA > ppk > 2025-09-22_14-47-49 > PPK 

 

3.4.  Solution Using PPK Mode  

Select SLAM Measurement Mode – Handheld Solution. 
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Select PPK High-precision Solution, choose the rover and corresponding base station files, and set 

the base station coordinate information. 

The software does not support setting the source coordinate system, which defaults to WGS84. 

You can set the target coordinate system by filtering the EPSG code via the filter, or select it in the 

Coordinate Reference System field, and set the extended parameters as needed. 

 

Calculation exceptions will be displayed in Details. 

Once the solution is completed, the LAS data will load automatically. Click Exit to finish. 
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After the solution is completed, you can find the generated PPK data in the PPK folder under the 

data path. As shown in the screenshot, the full path is: 

(This PC) > (E:) (Local Disk (E:)) > TEST DATA > ppk > 2025-09-22_14-47-49 > PPK 

 

After the solution is completed, you can find the generated PPK data in the PPK folder under the 

data path. As shown in the screenshot, the full path is:  

(This PC) > (E:) (Local Disk (E:)) > TEST DATA > ppk > 2025-09-22_14-47-49 > PPK 
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4. Mobile Measurement Mode 

4.1. Start 

The main interface displays 'Recently Used Projects' and 'Recently Used Point Cloud Files' to help 

users quickly open projects and load point clouds. The left side provides functions such as 'New 

Project', 'Open Project', 'Save Function', 'Close Project', 'Recent Files', 'Plugin Management', 

'Registration Management', and 'Version Notes'. 

 

4.1.1. Creat a New Project 

（1） functional description ： 

Create a new project folder. 

（2） operating steps 

1. Click the New Project button under Start. 

 

2. Select a path and change the item name. 

3. Click Create 
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4.1.2. Open Project 

（1） functional description ： 

Open an existing project file. 

（2） operating steps ： 

1. Click the Open Project button under Start. 

2. Select an existing project file. 

 

3. Click "Open" to open the selected file. Click "Cancel" to close the file. 

4.1.3. Save project 

Save the current project. 

4.1.4. Close the project 

Close the current project. 

4.1.5. Plugin Management 

Select plugins to activate on the next software startup. 
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4.1.6. Imprint 

This section provides a brief description of the version number and ownership of the currently 

released version. 

4.2. Document 

 

4.2.1. Project 

The same as the functions in the Start menu in the previous section. 

4.2.2. Data Management 

4.2.2.1. Import point cloud 

（1）functional description ： 

This feature loads point cloud data from files into the software 

（2）operating steps ： 

1. Click the Import Point Cloud tool in the data menu bar. 
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2. Select the data file to load; 

3. Click to open and load the data. 

 

4.2.2.2. Export Point Cloud 

(1) Function description: 

This feature automatically exports selected measurement station data, supporting multiple 

formats including LAS, PLY, E57, and XYZ. It enables seamless conversion between data types, 

significantly boosting workflow efficiency. 

Note: ① Selecting multiple stations will export them as separate files, each named after the 

corresponding data. 

② Merge and export: Combine the selected station data into a single file. 

Click the dropdown triangle in the lower right corner to export the point cloud in TIF, SHP, or DXF 

formats. 

 

 

(2) Operation steps: 
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1. Click the "Export Point Cloud" button in the File menu. 

2. Select the data name to export. 

3. Set the export path and file name, and select the export format. 

4. Set whether to merge and export. 

5. After completing the settings, click the OK button to export. 

4.2.3. System Settings 

(1) Function description: 

This feature allows users to configure the software's display parameters and save paths, including: 

setting background colors or pixel sizes, adjusting display points based on computer performance, 

configuring browser settings, and fine-tuning zoom and rotation sensitivity. The save dialog 

enables modifications to project paths, export paths, and cache paths, as well as assigning color 

schemes to different categories during classification. 
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(2) Operation steps: 

Click System Settings in the File menu. 

Set the display parameters. 

Set the save, export, and cache paths for the project. 

Click Apply, then click OK to exit the interface and complete the parameter settings. 

Restore to default: Set all parameters to their default values. 

Cancel: Cancel system settings and exit the interface. 
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4.3. Show 

4.3.1. Rendering Mode 

The point cloud rendering modes mainly include elevation display, intensity display, category 

display, time display, True Color Display, file display, echo number display, edge display and EDL 

display. 

 

4.3.1.1. Elevation Display 

（1）Functional description ： 

The elevation value of point cloud data is mapped to a specified color range, which facilitates 

observing the elevation changes of point cloud data. 

（2）Operating steps ： 

1. Click the window loaded with point cloud data with the mouse to set it as the current active 

window. 

2. Select Display> Render Mode> Elevation Display in the menu bar , or choose Render 

on the toolbar to open the window shown below. 

 

3. Click Select Start Point to set the elevation color of the starting point 

4. Set the width of the color band and the color of the band 

5. Click OK to automatically map the elevation range of point cloud data to the selected color 

bar. The point cloud data in the scene will then display by elevation, enhancing the EDL display 

effect as shown in the figure. 
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4.3.1.2. Intensity Display 

（1）Functional description ： 

The intensity value of point cloud data is mapped to the uniform color range. 

（2）Operating steps ： 

1. Click the window loaded with point cloud data with the mouse to set it as the current active 

window. 

2. Select from the menu bar: Display-Render Mode -Intensity Display , or choose Render 

on the toolbar to open the window shown below. 
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3. Set color bands 

4. Click OK to automatically map the intensity range of point cloud data to the selected color bar, 

and display the point cloud data in the scene according to its intensity. The result is shown in the 

figure. 

 

4.3.1.3. True Color Display 

（1）Functional description ： 

It can display point cloud data by rendering the RGB color attributes of the point cloud data itself. 

（2）Operating steps ： 

1. Click the window loaded with point cloud data with the mouse to set it as the current active 

window. 

2. Select from the menu bar: Display-Render Mode -True Color Display or choose 

Render on the toolbar, as shown in the figure below. 
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4.3.1.4. Flight Line Display 

（1）Functional description ： 

It can be used to display point cloud data by mapping the edge attributes of different flight paths 

to distinct color values, enabling more intuitive differentiation of point cloud data along various 

flight paths. 

（2）Operating steps ： 

1. Click the window loaded with point cloud data with the mouse to set it as the current active 

window. 

2. In the menu bar, select Display> Render Mode> Ribbon Edge Display , or choose 

Render on the toolbar to open the window shown below. 
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3. Select different color values for different flight zone edges 

4. Click the confirm button to automatically map the different flight path edges of the point 

cloud data to corresponding colors, while the point cloud data in the scene is displayed along the 

flight path edges, as shown in the figure. 



28 
 

 

4.3.1.5. File View 

（1）functional description ： 

It can display point cloud data by mapping the point cloud data file to different color values, 

making it easier to distinguish between different files. 

（2）operating steps ： 

1. Click the window loaded with point cloud data with the mouse to set it as the current active 

window. 

2. Select Display> Render Mode> File Display in the menu bar or choose Render on 

the toolbar to open the window shown below. 
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3. Select different color values for different files 

4. Click the confirm button to display the point cloud data in the scene with the selected color 

by file. The EDL display effect is enhanced when combined, as shown in the figure. 
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4.3.1.6. Echo Count Display 

（1）Functional description ： 

Display the echo count attribute of point clouds in different colors to visually distinguish point 

cloud data with varying echo counts. 

（2）Operating steps ： 

1. Click the window loaded with point cloud data with the mouse to set it as the current active 

window. 

2. In the menu bar, select Display> Render Mode> Echo Count Display, or choose Render on the 

toolbar to open the window shown below. 

 

3. Select different color values for different echo counts 

4. Click the confirm button to automatically map the point cloud data's echo counts to 

corresponding colors, with the scene displaying the data by echo count. The result is shown in the 

figure. 
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4.3.1.7. Category Display 

（1）Functional description ： 

It can be used to display point cloud data by mapping the category attributes of point cloud data 

to different color values, making it easier to distinguish between different categories of point cloud 

data. 

（1）Operating steps ： 

1. Click the window loaded with point cloud data with the mouse to set it as the current active 

window. 

2. Select from the menu bar: Display-Render Mode -Category Display , or choose 

Render from the toolbar to open the window shown below. 
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3. Select different color values for different categories 

4. Click the confirm button to automatically map different point cloud categories to 

corresponding colors, with the data displayed by category in the scene. The result is shown in the 

figure. 
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4.3.1.8. Time Display 

（1）Functional description ： 

Based on the GPS time value, map the time attribute to a uniformly varying color value. 

（2）Operating steps ： 

1. Click the window loaded with point cloud data with the mouse to set it as the current active 

window. 

2. Select from the menu bar: Display-Render Mode -Time Display, or choose Render 

on the toolbar. The window will pop up as shown in the figure below. 

 

3. Select the appropriate ribbon from the drop-down list. 
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4. Click the confirm button to automatically map the GPS time variation range of point cloud 

data to corresponding colors, while the point cloud data in the scene is displayed according to GPS 

time. The display effect is shown in the figure. 

 

4.3.1.9. EDL Display 

（1） Functional description ： 

Enable EDL effects for the active view to enhance detail contrast and improve display quality. This 

feature is often used with other rendering methods to highlight object contour details for better 

visibility. To achieve optimal EDL rendering results, manually set the view to perspective 

projection. 

（2） Operating steps ： 

1. Click the window loaded with point cloud data with the mouse to set it as the current active 

window. 

2. In the menu bar, select Display> Render Mode > EDL Display, or choose Render on 

the toolbar. The display effect is shown in the figure. 
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4.3.2. View 

4.3.2.1. Top View 

（1）Functional description ： 

Set the camera position to view the top-down perspective, which is the 3D data view from the +z 

to-z direction, with the plane being the x-y plane. 

（2）Operating steps ： 

1. Open the view and load the point cloud. Click the top view button to display the view 

as shown in the figure. 
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Menu: Show Top View. 

4.3.2.2. Bottom View 

（1）Functional description ： 

Set the camera position to view the top-down perspective, which displays 3D data from-z to +z, 

with the x-y plane as the plane of view. 

（2）Operating steps ： 

1. Open the view and load the point cloud. Click the Top View button to display the view as 

shown in the figure. 
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Menu: Show Top View. 

4.3.2.3. Left View 

（1）Functional description ： 

Set the camera position to view the left view, which displays 3D data from-x to +x, with the y-z 

plane as the plane. 

（2）Operating steps ： 

1. Open the view and load the point cloud. Click the left view button to display the image: 
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Menu: Show left view . 

4.3.2.4. Right View 

（1）Functional description ： 

Set the camera to right view, viewing 3D data from +x to-x, with the y-z plane as the plane. 

（2）Operating steps ： 

1. Open the view and load the point cloud. Click the right view button with the mouse to 

display the image: 

 

Menu: Show right view. 

4.3.2.5. Front View 

（1）Functional description ： 



39 
 

Set the camera position to front view, viewing the 3D data from-y to +y, with the x-z plane as the 

plane. 

（2）Operating steps ： 

1. Open the view and load the point cloud. Click the Front View button to display the view 

as shown in the figure. 

 

Menu: Show Front View. 

4.3.2.6. Back View 

（1）Functional description ： 

Set the camera position to rear view, viewing 3D data from +y to-y, with the x-z plane as the plane. 

（2）Operating steps ： 

1. Open the view and load the point cloud. Click the view button with the mouse to 

display the view as shown in the figure: 

 

Menu: Show Back View. 
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4.3.2.7. Zoom to Global 

（1） Functional description ： 

Scale all data in the current point cloud model to the 3D window. 

（2） Operating steps ： 

1. Open the view and load the point cloud. Click the Zoom To Global button to display the 

image: 

 

Menu: Zoom to global view. 

4.3.2.8. 2D View 

（1） Functional description ： 

Display the current window in 2D view. 

（2） Operating steps ： 

1. Open the view and load the point cloud. Click the 2D fixed view button to display the 

image: 
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Menu: Zoom to global view. 

4.3.2.9. Create View 

（1） Functional description ： 

The New Window feature adds a new empty window to the system. 

（2） Operating steps ： 

1. Click the New View button to display the view as shown in the figure: 
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Menu: Show New View. 

4.3.3. Projection 

4.3.3.1. Orthographic Projection 

（1） Functional description ： 

Parallel projection is to move the projection center of central projection to infinity, so that the 

projection line becomes parallel to each other, and the projection plane is close to the source. 

Menu: Show parallel projection. 

4.3.3.2. Perspective Projection 

（1） Functional description ： 

Perspective projection is a kind of single surface projection which is close to the visual effect. 

Menu: Show Perspective Projection. 
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4.3.4. Window Management 

Supports closing and displaying controls for the current, non-current, and all windows. 

4.4. Tool 

 

4.4.1. Sectioning Tools 

 

4.4.1.1. Section 

（1） Functional description ： 

Open the section module's function panel to draw a section area in the main view window and 

display it in the section window. You can set the buffer size to adjust the section width. 

（2） Operating steps ： 

1. Click the "Section " button. 

2. Display the section view; 

3. (Optional) Set buffer thickness. Select to lock. 

4. Draw the section line in the main view and display the section view with the specified 

thickness, as shown in the figure. 
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4.4.1.2. Move Section Up 

（1） Functional description ： 

Supports users to move a section area of the same size upward from the current section. 

（2） Operating steps ： 

1. Click the "Move Up" button. 

2. Move the section area upward by the specified step size (set in section settings), and the 

section view area will refresh automatically. 

4.4.1.3. Move Section Down 

（1） Functional description ： 

Supports users to move a section area of the same size downward from the current section. 

（2） Operating steps ： 

1. Click the "Move Down" button. 

2. Move the section area downward by the specified step size (set in section settings), and the 

section view area will refresh automatically. 



45 
 

4.4.1.4. Move Section 

（1） Functional description ： 

When the mobile section tool is active, move the mouse to the section area in the window, then 

click the left mouse button. The mouse will change to a hand shape, and you can drag to adjust 

the section area. 

（2） Operating steps ： 

1. Click the "Move Down" button. 

2. Place the mouse over the section in the main view. The mouse turns into a hand shape. Click 

and drag the section to the target area, and the section view area will refresh automatically. 

4.4.1.5. Rotate Section 

（1） Functional description ： 

          Supports users to rotate the drawn section area according to the set angle 

（2） Operating steps ： 

1. Click the Rotate button. 

2. Rotate the section area at the specified angle (set in section settings), and the section view 

area will refresh automatically. 

4.4.1.6. Extend Section 

（1） Functional description ： 

          Supports users to extend the drawn section area length according to the set value. If 

the user sets a negative value, the drawn section area length will be reduced. 

（2） Operating steps ： 

1. Click the Expand button. 

2. The section area expands to both sides at the specified step size (set in section settings), and 

the section view area refreshes automatically. 
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4.4.1.7. Section View 

（1） Functional description ： 

The software supports adjusting the view angle of the section window, providing four view modes: 

front view, left view, rear view, and right view. 

（2） Operating steps ： 

1. Set a fixed view in the section view. 

 

2. The section is displayed in the view mode you set. 

4.4.1.8. Section Measurement 

（1） Functional description ： 

Supports measurement in the profile window. 

（2） Operating steps ： 

1. Click the section measurement tool; 

2. Measure in the section window, as shown in the figure. 
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4.4.2. Point Cloud Quality Inspection 

 

4.4.2.1. Control Point Check 

(1) Functional description ： 

Assess the coordinate accuracy of control points to ensure they fall within the specified error 

range. 

A control point file is a text file separated by commas or spaces. Each line must contain X, Y, and Z 

information. At least three control points are required to create a valid control point report. 
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The report shows the information of the height difference between the laser point cloud and the 

height control point, the statistical information of the height difference such as the average 

amplitude of the height difference, the mean error, the mean square error, the average value of 

the height difference, and the maximum and minimum height difference. 

(2) Operating steps 

1. Click the Control Point Check button; 

2. Import checkpoint files 

3. Import the control point file, as shown in the figure below 
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4. Click for precise calculation 

5. Output control point report; 

4.4.2.2. Quality Inspection Report 

(1) Functional description 

The quality inspection report tool generates a report on the elevation difference between the laser 

point cloud and ground control points, which can be used to verify the elevation accuracy of the 

laser point cloud and to enhance its precision by applying the calculated correction values. 

(2) Operating steps 

1. Click the Quality Inspection Report button; 

2. Select the point cloud; 

3. Select the range line path and control point path; 

4. Click OK to output the report. 

 

4.4.3. Airborne coordinate Transformation 

(1) Function description: 

The relative coordinates of point cloud are transformed into absolute coordinates by selecting the 

feature points or target sphere to calculate the transformation parameters. 

(2) Operation steps: 
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1. Click the Airborne Coordinate Conversion button in the Tools menu. 

2. Import point clouds that require coordinate transformation. 

3. Click "Airborne Coordinate Conversion" to add the point cloud to be converted
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, then click OK. 

4. Click "Template Library"> "Add Template", enter the template name, and add the 

source and target files. 

5. Note: Set the file sorting order correctly. 

 

 

6. After adding, click Calculate, then OK and Confirm. 

7. Select the output path, name the file, and click Apply to complete the conversion. 
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4.4.4. Point Cloud Tool 

4.4.4.1. Point Cloud Decimation 

(1) Function description: 

Dilution of point cloud data is carried out. 

(2) Operation steps: 

1. Click the point cloud thinning tool; 

2. Select the target point cloud; 

 

3. Select the sampling type and set the relevant parameters: 

Minimum point spacing (default: 0.0000): Users must set the minimum distance between two 

points to ensure that the spatial 3D minimum distance between any two points in the sampled 

point cloud is not less than this value. The larger the value, the fewer points are retained. 

Sampling rate (default: 99.99%): Users set the percentage of points to retain. In this mode, the 

software randomly retains a specified number of points. Retained points = Total points × Sampling 

rate. The parameter ranges from 0 to 100%. A smaller value means fewer points are retained. 
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Octree (default: 21): This mode allows users to select a subdivision level of an octree. At this level, 

the closest point to the center of each octree cell is retained. Range: 1~21. The smaller the value, 

the fewer points are retained. 

4. Set the output path; 

5. Click Export to export the point cloud after thinning. 

 

4.4.4.2. Point Cloud Denoising 

(1) Function description: 

Identify and remove outliers or noise in point cloud data to improve data quality and accuracy. 

(2) Operation steps: 

1. Click the denoising button under the tool; 

2. Select the point cloud from the list and enter the export name; 

 

 

3. Click OK to complete the point cloud denoising process. 

4.4.4.3. Point Density Measurement 

(1) Function description: 

Calculate the point cloud density of the selected target area. 

(2) Operation steps: 
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1. Click the "Dot Density Measurement" button under "Tools". 

2. Set calculation range parameters: style, diameter. 

3. Click the Select Point button and double-click the point cloud to select the center point 

4. Click to calculate and get the point cloud thickness result. 

4.4.5. Clipping Tools 

 

4.4.5.1. Circle Selection 

(1) Function description: 

Draw a circle to select point clouds. Selected point clouds will be highlighted for subsequent 

cropping. 

(2) Operation steps: 

1. Click the "Select Circle " button. 

2. Draw a circle on the point cloud and select the target area. 

3. The selected point cloud is highlighted in red, as shown in the image. 
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4.4.5.2. Rectangle Selection 

(1) Function description: 

Draw a rectangle to select point clouds. Selected point clouds will be highlighted for subsequent 

cropping. 

(2) Operation steps: 

1. Click the "Select Rectangle " button. 

2. Draw a rectangle on the point cloud and select the target area. 

3. The selected point cloud is highlighted in red, as shown in the image. 

 

4.4.5.3. Polygon Selection 

(1) Function description: 

Draw the polygon shape to select the point cloud. The selected point cloud will be highlighted for 

subsequent cropping. 

(2) Operation steps: 
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1. Click the Polygon Selection button. 

2. Draw a rectangle on the point cloud and select the target area. 

3. The selected point cloud is highlighted in red, as shown in the image. 

 

4.4.5.4. Deselect 

(1) Function description: 

Subtract selection applies to the current selection tool, indicating the current selection state and 

controlling whether the selected area is added or subtracted. This function works with polygon, 

rectangle, and circle selections. 

(2) Operation steps: 

1. A highlighted point cloud is selected. 

2. Select a drawing method: circle, rectangle, or polygon. 

3. Click to deselect 

4. Draw a selection range line on the point cloud. Double-click to confirm, and the system will 

automatically deselect the point cloud in the intersection of the 'selected range area' and the 

'selection range line', as shown in the figure. 
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4.4.5.5. Cut Inside 

(1) Function description: 

Crop all point cloud data in the window based on the current selection. Point clouds within the 

selection are cropped, while those outside are retained. 

(2) Operation steps: 

1. A highlighted point cloud is selected. 

2. Click to crop 

3. The point clouds within the selected area are deleted, while those outside are retained, as 

shown in the figure. 

 

4.4.5.6. Cut Outside 

(1) Function description: 

Crop all point cloud data in the window based on the current selection. Point clouds within the 

selection are retained, and those outside are cropped. 

(2) Operation steps: 

1. A highlighted point cloud is selected. 

2. Click to trim outside; 

3. The point clouds outside the selected region are deleted, while those inside are retained, as 

shown in the figure. 
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4.4.5.7. Cancel 

(1) Function description: 

Cancel cropping and clear all crop effects. 

(2) Operation steps: 

1. After selecting and cropping 

2. Click 'Undo' to automatically clear the selected point cloud and the cropped point cloud effects. 

4.4.5.8. Clipping Box 

(1) Function description: 

Create a transparent cube called the clipping box to contain point cloud data. You can toggle the 

display of node cloud data by moving any face of the clipping box, showing the point clouds inside 

while hiding those outside. The software provides three manipulation methods: "Rotate Clipping 

Box", "Translate Clipping Box", and "Zoom Clipping Box". Note: This feature only controls point 

cloud visibility (showing or hiding) without performing clipping operations. 

(2) Operation steps: 

1. Click the "Crop Box" button under "Tools " to display the image. 



59 
 

 

2. Click to select the mode for editing the cropping box: 

a. Select the zoom and crop box, then select a moving target at the center of one of its faces. 

Move it forward or backward to crop and zoom. 

b. Select the crop box, rotate the axis, and adjust the crop box. 

c. Select the crop box, move the axis, and adjust the crop box horizontally. 

3. Adjust the point cloud display to your desired effect. 

4. The point cloud outside the cropping box is automatically hidden, showing only the point cloud 

inside. 

4.4.5.9. Export Results 

(1) Function description: 

The export result is the remaining point cloud displayed in the cropped view. 

(2) Operation steps: 
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1. Click the Export Results button to open the dialog box, as shown in the figure below. 

 

2. Set the export path and format, then click OK; 

3. Successfully exported the cropped point cloud. 

4.4.6. Measurement Tools 

 

4.4.6.1. Point Measurement 

(1) Function description: 

Select a point from the point cloud and get its coordinates. 
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(2) Operation steps: 

1. Click the "Measure Point" button in the "Tools" menu. 

2. Select a point on the point cloud to obtain its coordinate information. 

4.4.6.2. Multi-point Measurement 

(1) Function description: 

Select points from the point cloud and get their coordinates. Supports measuring, recording, and 

exporting multiple point data. 
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(2) Operation steps: 

1. Click the Multi-point Measurement button in the Tools menu. 

2. The coordinates of a point are obtained by selecting a point on the point cloud. 

3. Optional: Click Export to export the point coordinate data from the selected list. 

4. (Optional) Select a target point in the list, then click Delete to remove the point data. 

4.4.6.3. Distance Measurement 

(1) Function description: 

Select two points, read their coordinates, and calculate the spatial distance between them. The 

software supports multi-segment distance measurement, export of measurement results, and 

perpendicular foot display, providing references for area calculation. 
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(2) Operation steps: 

1. Click the Length Measurement button in the Tools menu. 

2. Click OK for the first item. 

3. Click OK for the second point and calculate the spatial distance. 

4. (Optional) Click Export to save the point coordinates from the selected list. 

4.4.6.4. Angle Measurement 

(1) Function description: 

To measure the angle of an object in a point cloud, first select a point as the origin, then choose 

points A and B to form a plane, and calculate the angle ∠AOB. 
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(2) Operation steps: 

1. Click the Angle Measurement button. 

2. Click OK to set the origin. 

3. Click OK for the first item. 

4. Click OK for the second point and calculate the corresponding angle. 

4.4.6.5. Horizontal Angle Measurement 

(1) Function description: 

First, select a point as the origin, then choose points A and B, and calculate the horizontal angle of 

∠AOB in space. 



65 
 

 

(2) Operation steps: 

1. Click the "Horizontal Angle Measurement" button. 

2. Click OK to set the origin. 

3. Click OK for the first item. 

4. Click OK for the second point and calculate the corresponding horizontal angle. 

4.4.6.6. Vertical Distance Measurement 

(1) Function description: 

Calculate the perpendicular distance between two points. 
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(2) Operation steps: 

1. Click the 'Vertical Distance Measurement' button in the 'Tools' menu. 

2. Click OK for the first item. 

3. Click OK to proceed to the second step and calculate the vertical distance. 

4. Click OK for the second point and calculate the corresponding level 

4.4.6.7. Horizontal Distance Measurement 

(1) Function description: 

Calculate the horizontal distance between two points. 
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(2) Operation steps: 

1. Click the "Leveling" button in the "Tools " menu. 

2. Click OK for the first item. 

3. Click OK for the second point and calculate the horizontal distance. 

4.4.6.8. Slope Measurement 

(1) Function description: 

Select a point as the top of the slope, then select another point as the bottom of the slope, and 

calculate the slope between the two points. 
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(2) Operation steps: 

1. Click the Slope Measurement button in the Tools menu. 

2. Click to confirm the slope top. 

3. Click OK to calculate the slope. 

4.4.6.9. Exit Measurement 

(1) Function description: 

Exit measurement mode. 

(2) Operation steps: 

Click Exit Measurement to end the measurement. 

4.4.6.10. Area Measurement 

(1) Function description: 

Draw the calculation range on the point cloud to obtain the coordinates of each point, then 

project them onto a specified plane. The target projection area is calculated through coordinate 

calculations. This feature provides three projection plane options: "X-O-Y", "X-O-Z", and "Y-O-Z", 

and also supports custom projection planes for more flexible calculation of the projection area. 

(2) Operation steps: 

1. Click Area Measurement to display the measurement toolbar. 

 

2. Draw a polygon to select the area requiring calculation, as shown in the figure below. 
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3. Select projection planes: "X-O-Y", "X-O-Z", or "Y-O-Z". 

4. (Optional) Select a custom projection plane and draw it; 

5. Click Calculate to get the area of the target region on the specified projection plane using the 

toolbar. 

6. Click Cancel to cancel the calculation and clear the selected area; 

7. Click Exit to stop area calculation; 

4.5.  Mobile Mapping Workflow  

 

4.5.1. One-click Import  

(1) Function description: 

Supports importing standard-format data from the aircraft in a single batch as a preprocessing 

project group. If the data is not in a unified standard format, you can create a new preprocessing 

project group to import the relevant data separately. 

(2) Operation steps: 

1. Click the One-click Import button to open the import interface, as shown below 
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Import project group: Import standard-format data groups and automatically identify base 

station data, mobile station data, inertial navigation data, and scan data in the folder 

Add project group: Manually add empty project groups to include non-uniform data 

Delete project group: Select a project group to delete 

Clear all project groups : Clear all project groups from the list 

Sync parameters: Synchronize all selected parameters in the project group to all project groups 

Synchronize base stations: Sync the selected base station parameters (coordinates and elevation) 

from the project group to all project groups 

Device model : You can choose from two default models or customize a device template. 

Save and solve: Save the project group data to the right preprocessing panel and go directly to the 

solution interface to solve. 

Save: Save the project group data to the right preprocessing panel 

Exit: Exit the import interface 

2. Save the data in the standard format folder shown below. The system will automatically 

recognize and load the files (the POS folder is the default output path after successful computation, 

and the LAS folder is the default output path after successful point cloud fusion). 
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3. Click the import button below, select the main folder directory, and the software will 

automatically recognize and load the corresponding data into the right panel. If the data is not 

saved in a standard file format, click the "+" button to create a new project group, then manually 

load the data in the "Calculation Configuration" interface on the right. 
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4. Modify the parameters in the right-hand "Calculation Configuration" panel according to the 

project requirements 

Recent usage: Records the last ten base station data. Click 'Recent usage' to display the panel 

below (with edit and remove options). Select a set of base station data, and it will be automatically 

applied to the corresponding project group. 

 

More: Click 'More' to open the following interface, which supports setting up combined inertial 

navigation systems (INS), INS types, and time settings. 
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5. (Optional) Click Save to automatically list the loaded data in the Preprocessing Management 

Panel. (Click Save and Solve to open the Solve panel and start solving directly.) 
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6. (Optional) Click "Save and Solve" to open the calculation panel and start solving directly, as 

shown in the figure below. 

 

7. (Optional) Click Exit to close the current interface. 

4.5.2. Trajectory Processing  

（1） Functional description ： 
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Calculate and generate trajectory files for the corresponding project using the original base station, 

mobile station, and inertial navigation data, supporting multiple project teams to resolve the issue. 

（2） Operating steps ： 

Prerequisite: The project data has been imported all relevant data and configured the base station 

coordinates and inertial navigation system type correctly. 

1. Click the "pos" button to open the calculation interface. Select the corresponding project 

group and click "Start Calculation" as shown in the figure below. 

 

2. Upon successful computation, the generated POS data will be automatically loaded into the 

Preprocessing Manager, with a POS folder created under the original path for storage. 
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3. Click the Quality Check Report to display the Quality Check icon, which allows you to check 

information such as base stations, mobile stations, and calculation status, as shown in the figure. 

 

4.5.3. Photo Organization 

Organize photo data and provide photo alignment and POS sorting functions. 

 

4.5.4. Trajectory Segmentation 

Split and trim the trajectory file pos for subsequent point cloud fusion. The software provides 

division methods including brush selection, time selection, polygon deletion, and polygon 
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selection. 

 

4.5.4.1. Import Trajectory 

functional description ： 

Select a trajectory file from the project group for segmentation. Supports loading external 

imported POS data files. 

 

operating steps ： 

Click the "Import Route" button to activate the "Edit Route" interface, as shown in the figure 

below. 
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Set up the coordinate system: including ellipsoid parameters, projection parameters, and seven 

parameters. The software will automatically calculate and select the corresponding central 

meridian, eastward constant, and scale when the track file is selected. 

Import POS files: Supports designated engineering teams to import externally calculated POS files 

for route division 

 

Note: To load and merge the POS calculated by IE, right-click 'Import POS' in the Preprocessing 

Manager, then proceed with route division. 

4.5.4.2. Brush Select 

（1） functional description ： 

Select the brush tool to choose the endpoints of the route to be trimmed and highlight them with 

color. The selected route will automatically appear in the flight path manager panel. 

（2） operating steps ： 

1. Select "Brush Selection ", choose a point on the route, and draw 

along the route to another point. Highlight the route between the two points. The selected route 

will be listed in the "Track List" panel. 
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4.5.4.3. Brush Delete 

（1） functional description ： 

Select the route to delete with the brush tool. 

（2） operating steps ： 

1. Select "Delete Brush " , choose a point on the route, then draw 

along the route to another point. Highlight the route between the two points. The selected route 

will be listed in the "Track Manager" panel. 

 

4.5.4.4. Time Select 

（1） Operating steps ： 
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1. Click the time selection button to display the track map panel at 

the bottom, as shown in the figure. 

 

2. Optional: Select the display properties for the track, including height, Roll, Pitch, or Heading. 

3. Optional: Click the button to the right of the start time to select a time point on the route 

as the start time. 

4. (Optional) Click the button to the right of the end time to select a time point on the route 

as the end time in the view. 

5. (Optional) Drag the start time slider to select the beginning of the track segment. 

6. Optional) Drag the end time slider to select the end time of the track segment. 

7. (Optional) Drag the red time labels on the chart to the start time. 

8. (Optional) Drag the red time labels on the chart to the start time. 

9. Routes selected during the specified time period will be highlighted, as shown in the figure. 
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10. (Optional) Click Trim Inside to delete the routes in the selected area. The result is shown in the 

figure. 

 

11. (Optional) Click Trim Outer to delete routes outside the selected area. The result is shown in 

the figure. 

 

 

4.5.4.5. Polygon Select 

（1） Operating steps ： 

1. Select the Polygon Selection button and draw the area you want 

to select, as shown below. 
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2. Double-click to finish drawing, then select and highlight the flight path in the target area. The 

selected flight path will appear in the "Flight Manager" panel, as shown in the figure. 

 

4.5.4.6. Delete Polygon 

1. Select the Polygon Delete button and draw the area you want to 

select, as shown below. 
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2. Double-click to finish drawing and delete the flight path in the target area. The result is shown in 

the figure. 

 

4.5.4.7. Track Reconstruction 

（1）Operating steps ： 

1. Click the track restoration button to restore the original track of the 
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POS data. Note: Selected route segments in the track manager panel will not be cleared. This 

operation applies to restoring polygon deletions, time selection, and clipping operations. 

4.5.4.8. Track Segment 

（1）Operating steps ： 

1. Click the "Route Segmentation " button. Rotate the selected 

route and then rotate the track to segment the chosen route. (Note: After route segmentation, the 

segmented POS files will be generated in the selected source POS folder. The source POS will not 

be deleted.) 

 

4.5.5. Point Cloud Fusion  

（1） Functional description ： 

The division of the engineering group's pos trajectory file and the original laser scanning data sls 

are fused to output a universal point cloud format. 

（2） Operating steps ： 

1. Click on point cloud fusion to display the fusion interface, as shown below. 

 

2. Set parameter settings to automatically link scanned data and POS data to the corresponding 

data in the project directory tree (the point cloud output path is the source project's LAS file by 
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default). 

 

3. Set fusion parameters. If you select a parameter template, the system default parameters 

cannot be modified. If you select a custom template, manually enter calibration and filtering 

parameters. Click Save Template to save for future use and editing. 

4. (Optional) Click Apply to apply the calibration and filtering parameters to the current project 

group 

5. (Optional) Click All Apps to apply the calibration and filtering parameters to all project groups 

6. (Optional) Click Exit to close the merge settings interface 

7. Select the engineering group to merge, then click the "Start Merge" button to merge point 

clouds. 

(Note: The coordinate system of the POS must be set and saved in the flight path division before 

merging; otherwise, merging cannot be performed.) 

(Note: Failed to read the SLS or POS file. Check if the parameter file is in the log folder or at the 

same level as the SLS folder.) 

8. Integration succeeded. A prompt appears asking 'Import point cloud?' Select 'Import to project' 

as shown below. 
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4.5.6. Point Cloud Refinement  

（1） Functional description ： 

If the point cloud still has layering after the placement is completed, it may be due to excessive errors in 

the trajectory itself. The point cloud refinement function can be used to post-process the trajectory and 

point cloud to reduce the errors. 
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4.5.7. One-click Processing  

（1） Feature Description: The software supports one-click processing for data import, calculation, 

photo organization, flight path division, point cloud fusion, and point cloud refinement. 

（2） Operating steps ： 

1. Click the One-Click Import button to open the One-Click Processing interface, as 

shown below 

 

2. Check the corresponding data to indicate whether it was recognized or not. 

3. Click Next to automatically copy the data and enter the parameter settings as shown below: 
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4. Click to select the base station, check for errors, and 

enter the fusion parameters 

 

Select merge mode 

 

Check refinement mode to generate a refinement report. 

5. Click Next to automatically check the data as shown below: 
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6. Click Next to generate a refined point cloud and corresponding report automatically. 

 

4.5.8. Tool 

4.5.8.1. Boresight Calibration 

（1） Functional description ： 

The software provides calibration views that display alongside cross-section views. By adjusting roll, 

pitch, and heading values, users can view real-time corrected point cloud effects. It also supports 

saving modified boresight angle parameters for point cloud fusion. 

（2） Operating steps ： 

1. Click the boresight angle calibration button to open the calibration interface. 

2. Select the engineering group to calibrate, then click Import Data to display the result as shown. 

(Note: The alignment angle calibration function has a specific rendering mode and does not 

support adjusting the rendering mode.) 
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Select a section: Re-trigger the section selection function to draw the section 

Cross-section width: Set the width of the cross-section when selecting points 

Save parameters: Update and save the adjusted parameters to the point cloud fusion function 

Step size: Set the mouse movement step size to quickly adjust roll, pitch, and heading values. 

Display control of digital airway: Control the display of corresponding digital airway point cloud 

3. Double-click the point cloud to select the first point, then double-click to select the second 

point for cross-section point selection. The software will automatically display the cross-section 

view as shown in the figure below. (Note: In the calibration window, the default view is the 

cross-section point selection function. If you need to restore this function after using other 

measurement tools, click the 'Cross-Section Point Selection' option in the right panel to reactivate 

the cross-section function.) 
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4. (Optional) Adjust the roll, pitch, heading, and other parameters to observe the point cloud 

overlap in the profile view until the point clouds align. 

5. Click Update All to apply the modified parameters to all point clouds 

6. Save the parameters to use the current adjusted parameters as fusion parameters and update 

them synchronously to the fusion human parameters in the point cloud fusion function. 

7. Click Exit Calibration to confirm. The confirmation panel will appear. Confirm to exit the 

boresight angle calibration interface. 

4.5.8.2. Airborne Orthophoto Coloring  

（1）Functional description ： 

The real color information is applied to the orthophoto, so that the generated image has the 

geometric precision of the orthophoto and the color of the real world. 

（2）Operating steps ： 

（3）1. Click the airborne orthophoto coloring tool 

（4）2. Import the tif file 

 

2. Enter the export name. 

3. 4. Click OK and wait for coloring to complete. 
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5. Terrestrial Mode  

5.1. Start 

The main interface displays 'Recently Used Projects' and 'Recently Used Point Cloud Files' to help 

users quickly open projects and load point clouds. The left side provides functions such as 'New 

Project', 'Open Project', 'Save Function', 'Close Project', 'Recent Files', 'Plugin Management', 

'Registration Management', and 'Version Notes'. 

 

5.1.1. Creat a New Project 

（1） Functional description ： 

Create a new project folder. 

（2） Operating steps 

1. Click the New Project button under Start. 

 

2. Select a path and change the item name. 



93 
 

3. Click Create 

5.1.2. Open Project 

（1） Functional description ： 

Open an existing project file. 

（2） Operating steps ： 

1. Click the Open Project button under Start. 

2. Select an existing project file. 

 

3. Click "Open" to open the selected file. Click "Cancel" to close the file. 

5.1.3. Save project 

Save the current project. 

5.1.4. Close the project 

Close the current project. 

5.1.5. System Settings 

Select all plugins to activate when the software starts next time. 
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5.1.6. Imprint 

This section provides a brief description of the version number and ownership of the currently 

released version. 

 

5.2. Document 

 

5.2.1. Project 

The same as the functions in the Start menu from the previous section. 

5.2.2. Data 

5.2.2.1. Export Point Cloud 

（1） Functional description ： 

This feature automatically exports selected measurement station data, supporting multiple 

formats including LAS, PLY, E57, and XYZ. It enables seamless conversion between data types, 

significantly boosting workflow efficiency. 
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Note: ① Selecting multiple stations will export them as separate files, each named after the 

corresponding data. 

② Merge and export: Combine the selected station data into a single file. 

Click the dropdown triangle in the lower right corner to export the point cloud in TIF, SHP, or DXF 

formats. 

 

 

（2） Operating steps ： 

1. Click the Export Point Cloud button in the File menu. 

2. Check the data name to export. 

3. Set the export path and file name, and select the export format. 
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4. Set whether to merge exports. 

5. After completing the settings, click OK to export. 

5.2.3. System Settings 

（1） Functional description ： 

This feature allows users to configure the software's display parameters and save paths, including: 

setting background colors or pixel sizes, adjusting display points based on computer performance, 

configuring browser settings, and fine-tuning zoom and rotation sensitivity. The save dialog 

enables modifications to project paths, export paths, and cache paths, as well as assigning color 

schemes to different categories during classification. 

 

 



97 
 

 

（2） Operating steps ： 

1. Click System Settings in the File menu. 

2. Set the display parameters. 

3. Set the save, export, and cache paths for the project. 

4. Click Apply, then click OK to exit the interface and complete parameter settings. 

5. Restore to default: Set all parameters to their default values. 

6. Cancel: Cancel system settings and exit the interface. 

5.3. Show 

5.3.1. Rendering Mode 

The point cloud rendering modes mainly include elevation display, intensity display, category 

display, time display, true color display, file display, echo number display, edge display and EDL 

display. 
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5.3.1.1. Elevation Display 

（1）Functional description ： 

The elevation values of point cloud data are mapped to a specified color range, facilitating the 

observation of elevation variations in point cloud data. 

（2）Operating steps ： 

1. Click the window loaded with point cloud data with the mouse to set it as the current active 

window. 

2. Select Display> Render Mode> Elevation Display in the menu bar , or choose Render 

on the toolbar to open the window shown below. 

 

3. Click Select Start Point to set the elevation color of the starting point 
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4. Set the width of the color band and the color of the band 

5. Click OK to automatically map the elevation range of point cloud data to the selected color 

bar. The point cloud data in the scene will then display by elevation, enhancing the EDL display 

effect as shown in the figure. 

 

5.3.1.2. Intensity Display 

（1）Functional description ： 

The intensity value of point cloud data is mapped to the uniform color range. 

（2）Operating steps ： 

1. Click the window loaded with point cloud data with the mouse to set it as the current active 

window. 

2. Select from the menu bar: Display-Render Mode -Intensity Display , or choose Render 

on the toolbar. The window will pop up as shown in the figure below. 
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3. Set color bands 

4. Click OK to automatically map the intensity range of point cloud data to the selected color bar, 

and display the point cloud data in the scene according to its intensity. The result is shown in the 

figure. 

 

5.3.1.3. True Color Display 

（1）Functional description ： 

It can display point cloud data by rendering the RGB color attributes of the point cloud data itself. 

（2）Operating steps ： 

1. Click the window loaded with point cloud data with the mouse to set it as the current active 

window. 

2. Select from the menu bar: Display-Render Mode -True Color Display or choose 

Render on the toolbar, as shown in the figure below. 



101 
 

 

5.3.1.4. File Display 

（1）Functional description ： 

It can display point cloud data by mapping the point cloud data file to different color values, 

making it easier to distinguish between different files. 

（2）Operating steps ： 

1. Click the window loaded with point cloud data with the mouse to set it as the current active 

window. 

2. Select from the menu bar: Display-Render Mode -File Display, or choose Render on 

the toolbar to open the window shown below. 

 

3. Select different color values for different files 
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4. Click the confirm button to display the point cloud data in the scene with the selected color 

by file. The EDL display effect is enhanced when combined, as shown in the figure. 

 

5.3.1.5. Category Display 

（1）Functional description ： 

It can be used to display point cloud data by mapping the category attributes of point cloud data 

to different color values, making it easier to distinguish between different categories of point cloud 

data. 

（1）Operating steps ： 

1. Click the window loaded with point cloud data with the mouse to set it as the current active 

window. 

2. Select from the menu bar: Display-Render Mode -Category Display , or choose 

Render from the toolbar to open the window shown below. 
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3. Select different color values for different categories 

4. Click the confirm button to automatically map different point cloud categories to 

corresponding colors, with the data displayed by category in the scene. The result is shown in the 

figure. 

 

5.3.1.6. Time Display 

（1）Functional description ： 

Based on the GPS time value, map the time attribute to a uniformly varying color value. 

（2）Operating steps ： 

1. Click the window loaded with point cloud data with the mouse to set it as the current active 

window. 
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2. Select from the menu bar: Display-Render Mode -Time Display, or choose Render 

on the toolbar. The window will pop up as shown in the figure below. 

 

3. Select the appropriate ribbon from the drop-down list. 

4. Click the confirm button to automatically map the GPS time variation range of point cloud 

data to corresponding colors, while the point cloud data in the scene is displayed according to GPS 

time. The display effect is shown in the figure. 

 

5.3.1.7. Flight Line Display 

（1）Functional description ： 

It can be used to display point cloud data by mapping the edge attributes of different flight paths 

to distinct color values, enabling more intuitive differentiation of point cloud data along various 

flight paths. 

（2）Operating steps ： 

1. Click the window loaded with point cloud data with the mouse to set it as the current active 

window. 
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2. In the menu bar, select Display> Render Mode> Ribbon Edge Display , or choose 

Render on the toolbar to open the window shown below. 

 

3. Select different color values for different flight zone edges 

4. Click the confirm button to automatically map the different flight path edges of the point 

cloud data to corresponding colors, while the point cloud data in the scene is displayed along the 

flight path edges, as shown in the figure. 

 

5.3.1.8. EDL Show 

（1） Functional description ： 

Enable EDL effects for the active view to enhance detail contrast and improve display quality. This 

feature is often used with other rendering methods to highlight object contour details for better 
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visibility. To achieve optimal EDL rendering results, manually set the view to perspective 

projection. 

（2） Operating steps ： 

1. Click the window loaded with point cloud data with the mouse to set it as the current active 

window. 

2. In the menu bar, select Display> Render Mode > EDL Display, or choose Render 

on the toolbar. The display effect is shown in the figure. 

 

5.3.1.9. Echo Count Display 

（1）Functional description ： 

Display the echo count attribute of point clouds in different colors to visually distinguish point 

cloud data with varying echo counts. 

（2）Operating steps ： 

1. Click the window loaded with point cloud data with the mouse to set it as the current active 

window. 

2. In the menu bar, select Display> Render Mode> Echo Count Display, or choose Render on the 

toolbar to open the window shown below. 
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3. Select different color values for different echo counts 

4. Click the confirm button to automatically map the point cloud data's echo counts to 

corresponding colors, with the scene displaying the data by echo count. The result is shown in the 

figure. 

 

5.3.2. View 

5.3.2.1. Top View 

（1）Functional description ： 

Set the camera position to view the top-down perspective, which is the 3D data view from the +z 

to-z direction, with the plane being the x-y plane. 
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（2）Operating steps ： 

1. Open the view and load the point cloud. Click the top view button to display the view 

as shown in the figure. 

 

Menu: Show Top View. 

5.3.2.2. Bottom View 

（1）Functional description ： 

Set the camera position to view the top-down perspective, which displays 3D data from-z to +z, 

with the x-y plane as the plane of view. 

（2）Operating steps ： 

1. Open the view and load the point cloud. Click the Top View button to display the view as 

shown in the figure. 
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Menu: Show Top View. 

5.3.2.3. Left View 

（1）Functional description ： 

Set the camera position to view the left view, which displays 3D data from-x to +x, with the y-z 

plane as the plane. 

（2）Operating steps ： 

1. Open the view and load the point cloud. Click the left view button with the mouse to 

display the image: 
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Menu: Show left view. 

5.3.2.4. Right View 

（1）Functional description ： 

Set the camera to right view, viewing 3D data from +x to-x, with the y-z plane as the plane. 

（2）Operating steps ： 

1. Open the view and load the point cloud. Click the right view button with the mouse to 

display the image: 
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Menu: Show right view. 

5.3.2.5. Front View 

（1）Functional description ： 

Set the camera position to front view, viewing the 3D data from-y to +y, with the x-z plane as the 

plane. 

（2）Operating steps ： 

1. Open the view and load the point cloud. Click the Front View button to display the view 

as shown in the figure. 
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Menu: Show Front View. 

5.3.2.6. Back View 

（1）Functional description ： 

Set the camera position to rear view, viewing 3D data from +y to-y, with the x-z plane as the plane. 

（2）Operating steps ： 

1. Open the view and load the point cloud. Click the view button with the mouse to 

display the view as shown in the figure: 
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Menu: Show Back View. 

5.3.2.7. Zoom to Global 

（1） Functional description ： 

Scale all data in the current point cloud model to the 3D window. 

（2） Operating steps ： 

1. Open the view and load the point cloud. Click the Zoom To Global button to display the 

image: 
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Menu: Zoom to global view. 

5.3.2.8. 2D View 

（1） Functional description ： 

Display the current window in 2D view. 

（2） Operating steps ： 

1. Open the view and load the point cloud. Click the 2D fixed view button to display the 

image: 
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Menu: Zoom to global view. 

5.3.2.9. Show Station 

（1） Functional description ： 

This function can control the display status of the station in 3D view. 

（2） Operating steps ： 

1. Open the view and load the point cloud. Click the station display button with the 

mouse to show the image below: 
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Menu: "Show" displays the station. 

5.3.2.10. New View 

（1） Functional description ： 

The New Window feature adds a new empty window to the system. 

（2） Operating steps ： 

1. Click the New View button to display the view as shown in the figure: 

 

Menu: Show New View. 

5.3.3. Projection Mode 

5.3.3.1. Orthographic Projection 

（1） Functional description ： 

Parallel projection is to move the projection center of central projection to infinity, so that the 

projection line becomes parallel to each other, and the projection plane is close to the source. 

Menu: Show parallel projection. 
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5.3.3.2. Perspective Projection 

（2） Functional description ： 

Perspective projection is a kind of single surface projection which is close to the visual effect. 

Menu: Show Perspective Projection. 

5.3.4. View Mode 

5.3.4.1. Check-in Browsing 

（1） Functional description ： 

In the inspection mode, the point cloud can be freely rotated, scaled, and dragged to facilitate 

comprehensive observation and browsing of the point cloud data. 

 

Menu: Show checklist view. 

5.3.4.2. Base Station 

（1） Functional description ： 

Base station-based panoramic view mode. Click the direction buttons below to switch the base 

station view. When using rear-view orientation, you can quickly locate targets and collect puncture 

points in base station mode. 
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Menu: Show based on base station 

5.3.5. Window Management 

Supports closing and displaying controls for the current, non-current, and all windows. 

5.4. Tool 

 

5.4.1. Measurement Tools 

 

5.4.1.1. Point Measurement 

（1） Functional description ： 
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Select a point from the point cloud and get its coordinates. 

 

（2） Operating steps ： 

1. Click the Point Measurement button in the Tools menu. 

2. The coordinates of a point are obtained by selecting a point on the point cloud. 

5.4.1.2. Multi-point Measurement 

（1） Functional description ： 

Select points from the point cloud and get their coordinates. Supports measuring, recording, and 

exporting multiple point data. 
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（2） Operating steps ： 

1. Click the Multi-point Measurement button in the Tools menu. 

2. The coordinates of a point are obtained by selecting a point on the point cloud. 

3. Optional: Click Export to export the point coordinate data from the selected list. 

4. (Optional) Select a target point in the list, then click Delete to remove the point data. 

5.4.1.3. Distance Measurement 

（1） Functional description ： 

Select two points, read their coordinates, and calculate the spatial distance between them. The 

software supports multi-segment distance measurement, export of measurement results, and 

perpendicular foot display, providing references for area calculation. 
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（2） Operating steps ： 

1. Click the Length Measurement button in the Tools menu. 

2. Click to confirm the first point. 

3. Click to confirm the second point and calculate the spatial distance. 

4. Optional: Click Export to export the point coordinate data from the selected list. 

5.4.1.4. Angle Measurement 

（1） Functional description ： 

To measure the angle of an object in a point cloud, first select a point as the origin, then choose 

points A and B to form a plane, and calculate the angle ∠AOB. 
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（2） Operating steps ： 

1. Click the Angle Measurement button. 

2. Click to determine the origin. 

3. Click to confirm the first point. 

4. Click to confirm the second point and calculate the corresponding angle. 

5.4.1.5. Horizontal Angle Measurement 

（1） Functional description ： 

First, select a point as the origin, then choose points A and B, and calculate the horizontal angle of 

∠AOB in space. 
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（2） Operating steps ： 

1. Click the Horizontal Angle Measurement button. 

2. Click to determine the origin. 

3. Click to confirm the first point. 

4. Click to confirm the second point and calculate the corresponding horizontal angle. 

5.4.1.6. Vertical Distance Measuremen 

（1） Functional description ： 

Calculate the perpendicular distance between two points. 
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（2） Operating steps ： 

1. Click the Vertical Distance Measurement button in the Tools menu. 

2. Click to confirm the first point. 

3. Click to confirm the second point and get the calculated vertical distance. 

5.4.1.7. Horizontal Distance Measurement 

（1） Functional description ： 

Calculate the horizontal distance between two points. 
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（2） Operating steps ： 

1. Click the "Level Distance Measurement" button in the Tools menu. 

2. Click to confirm the first point. 

3. Click to confirm the second point and calculate the flat distance. 

5.4.1.8. Slope Measurement 

（1） Functional description ： 

Select a point as the top of the slope, then select another point as the bottom of the slope, and 

calculate the slope between the two points. 

 

（2） Pperating steps ： 

1. Click the Slope Measurement button in the Tools menu. 

2. Click to determine the slope top. 

3. Click to determine the slope base and calculate the slope. 

5.4.1.9. Exit Measurement 

（1） Functional description ： 

Exit measurement mode. 

（2） Operating steps ： 

Click Exit Measurement to end the measurement. 
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5.4.1.10. Area Measurement 

（1） Functional description ： 

Draw the calculation range on the point cloud to obtain the coordinates of each point, then 

project them onto a specified plane. The target projection area is calculated through coordinate 

calculations. This feature provides three projection plane options: "X-O-Y", "X-O-Z", and "Y-O-Z", 

and also supports custom projection planes for more flexible calculation of the projection area. 

（2） Operating steps ： 

1. Click Area Measurement to display the measurement toolbar. 

 

2. Draw a polygon to select an area requiring calculation, as shown below. 

 

3. Select projection planes: "X-O-Y", "X-O-Z", or "Y-O-Z". 

4. Optional: Select a custom projection plane to draw a custom projection plane. 

5. Click Calculate to get the area of the target region on the specified projection plane. 

6. Click Cancel to cancel the calculation and clear the selected area. 

7. Click Exit to stop area calculation 
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5.4.2. Clipping Tools 

 

5.4.2.1. Circle Selection 

（1） Functional description ： 

          Draw a circle to select point clouds. Selected point clouds will be highlighted for 

subsequent cropping. 

（2） Operating steps ： 

1. Click the "Select Circle " button. 

2. Draw a circle on the point cloud and select the target area. 

3. The selected point cloud is highlighted in red, as shown in the image. 

 

5.4.2.2. Rectangle Selection 

（1） Functional description ： 
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Draw a rectangle to select point clouds. Selected point clouds will be highlighted for subsequent 

cropping. 

（2） Operating steps ： 

1. Click the "Select Rectangle " button. 

2. Draw a rectangle on the point cloud and select the target area. 

3. The selected point cloud is highlighted in red, as shown in the image. 

 

5.4.2.3. Polygon Selection 

（1） Functional description ： 

Draw the polygon shape to select point clouds. Selected point clouds will be highlighted for 

subsequent cropping. 

（2） Operating steps ： 

1. Click the Polygon Selection button. 

2. Draw a rectangle on the point cloud and select the target area. 

3. The selected point cloud is highlighted in red, as shown in the image. 
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5.4.2.4. Deselect 

（1） Functional description ： 

Subtract selection applies to the current selection tool, indicating the current selection state and 

controlling whether the selected area is added or subtracted. This function works with polygon, 

rectangle, and circle selections. 

（2） Operating steps ： 

1. A highlighted point cloud is selected. 

2. Select a drawing method: circle, rectangle, or polygon. 

3. Click to deselect 

4. Draw a selection range line on the point cloud. Double-click to confirm, and the system will 

automatically deselect the point cloud in the intersection of 'selected range area' and 'selection 

range line', as shown in the figure. 
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5.4.2.5. Crop Inside 

（1） Functional description ： 

Crop all point cloud data in the window based on the current selection. Point clouds within the 

selection are cropped, while those outside are retained. 

（2） Operating steps ： 

1. A highlighted point cloud is selected. 

2. Click to crop 

3. The point clouds within the selected area are deleted, while those outside are retained, as 

shown in the figure. 

 

5.4.2.6. Crop Outside 

（1） Functional description ： 

Crop all point cloud data in the window based on the current selection. Point clouds within the 

selection are retained, and those outside are cropped. 

（2） Operating steps ： 

1. A highlighted point cloud is selected. 

2. Click to trim outside; 

3. The point clouds outside the selected region are deleted, while those inside are retained, as 

shown in the figure. 
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5.4.2.7. Cancel 

（1） Functional description ： 

Cancel cropping and clear all crop effects. 

（2） Operating steps ： 

1. After selecting and cropping 

2. Click Cancel to automatically clear the selected point cloud and the cropped point cloud 

effects. 

5.4.2.8. Clipping Box 

（1） Functional description ： 

Create a transparent cube called the clipping box to contain point cloud data. You can toggle the 

display of node cloud data by moving any face of the clipping box, showing the point clouds inside 

while hiding those outside. The software provides three manipulation methods: "Rotate Clipping 

Box", "Translate Clipping Box", and "Zoom Clipping Box". Note: This feature only controls point 

cloud visibility (showing or hiding) without performing clipping operations. 

（2） Operating steps ： 

1. Click the Crop Box button under Tools to display the image. 
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2. Select the mode to edit the cropping box: 

a. Select the zoom and crop box, then select a moving target at the center of one of its faces to 

zoom and crop by moving it forward or backward. 

b. Select the crop box, rotate the axis, and adjust the crop box. 

c. Select the crop box, move the axis, and adjust the crop box horizontally. 

3. Adjust the point cloud display to your desired effect. 

4. The point cloud outside the cropping box is automatically hidden, and only the point cloud 

inside the cropping box is displayed. 

5.4.2.9. Export Results 

（1） Functional description ： 

The export result is the remaining point cloud displayed in the cropped view. 

（2） Operating steps ： 

1. Click the Export Results button to open the dialog box, as shown below. 
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2. Set the export path and format, then click OK. 

3. Successfully exported the cropped point cloud. 

5.4.3. Sectioning Tools 

5.4.3.1. Sectioning Tools 

（1） Functional description ： 

Open the section module's function panel to draw a section area in the main view window and 

display it in the section window. You can set the buffer size to adjust the section width. 

（2） Operating steps ： 

1. Click the "Section " button. 

2. Display the section view; 

3. (Optional) Set buffer thickness. Select to lock. 

4. Draw the section line in the main view and display the section view with the specified 

thickness, as shown in the figure. 
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5.4.3.2. Move Section Up 

（1） Functional description ： 

Supports users to move a section area of the same size upward from the current section. 

（2） Operating steps ： 

1. Click the "Move Up" button. 

2. Move the section area upward by the specified step size (set in section settings), and the 

section view area will refresh automatically. 

5.4.3.3. Move Section Down 

（1） Functional description ： 

Supports users to move a section area of the same size downward from the current section. 

（2） Operating steps ： 

1. Click the "Move Down" button. 

2. The section area moves downward by the specified step size (set in section settings), and the 

section view area updates automatically. 
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5.4.3.4. Move Section 

（1） Functional description ： 

When the mobile section tool is active, move the mouse to the section area in the window, then 

click the left mouse button. The mouse will change to a hand shape, and you can drag to adjust 

the section area. 

（2） Operating steps ： 

1. Click the "Move Down" button. 

2. Place the mouse over the section in the main view. The mouse turns into a hand shape. Click 

and drag the section to the target area, and the section view area will refresh automatically. 

5.4.3.5. Rotate Section 

（1） Functional description ： 

Supports users to rotate the drawn section area according to the set angle 

（2） Operating steps ： 

1. Click the Rotate button. 

2. Rotate the section area at the specified angle (set in section settings), and the section view 

area will refresh automatically. 

5.4.3.6. Extend Section 

（1） Functional description ： 

Supports users to extend the drawn section area length according to the set value. If the user sets 

a negative value, the drawn section area length will be reduced. 

（2） Operating steps ： 

1. Click the Expand button. 

2. The section area expands to both sides at the specified step size (set in section settings), and 

the section view area updates automatically. 
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5.4.3.7. Section Settings 

（1） Functional description ： 

Supports adjusting the profile's movement, rotation, and step size 

（2） Operating steps ： 

1. Click the Settings button to open the settings window. 

 

2. Supports setting features such as movement step, rotation step, and expansion step. 

3. Click OK to set up successfully. 

4. (Optional) Click Cancel to close the window. 

5.4.3.8. Section View 

（1） Functional description ： 

The software supports adjusting the view angle of the section window, providing four view modes: 

front view, left view, rear view, and right view. 

（2） Operating steps ： 

1. Set a fixed view in the section view. 
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2. The section is displayed in the view mode you set. 

5.4.3.9. Lock/Unlock View 

（1） Functional description ： 

Supports locking and unlocking the view of the section window. By default, the section does not 

support selection and rotation, but you can switch between them using the selection state. 

（2） Operating steps ： 

1. Select the rotate button in the section view. 

2. The section can be rotated. 

3. Click again to fix the view in section mode, which will enter 2D mode and cannot rotate. 

5.4.3.10. Section Measurement 

（1） Functional description ： 

Supports measurement in the profile window. 

（2） Operating steps ： 

1. Click the section measurement tool; 

2. Measure in the section window, as shown in the figure. 
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5.4.4. Quality Control 

5.4.4.1. Point Density Measurement 

（1） Functional description ： 

Calculate the point cloud density of the selected target area. 

（2） Operating steps ： 

 

1. Click the "Dot Density Measurement" button under "Tools". 

2. Set calculation range parameters: style, diameter. 

3. Click the Select Point button and double-click the point cloud to select the center point 

4. Click to calculate and get the point cloud thickness result. 

5. Click Close to disable point density measurement. 

5.4.4.2. Point Cloud Thickness Measurement 

(1) Description: Calculate the point cloud density of the selected target area. 

5.4.5. Point Cloud Tool 
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5.4.5.1. Coordinate Transformation 

（1） Functional description ： 

The relative coordinates of point cloud are transformed into absolute coordinates by selecting the 

feature points or target sphere to calculate the transformation parameters. 

（2） Operating steps ： 

 

1. Click the Coordinate Conversion button under the Point Cloud Processing menu. 

2. Import the point in the following way. 

a. Select the "Manual Point Selection" mode to pick feature points 

with known coordinates and set their world coordinates with the right-click option. 

b. Select the "Apply Target Ball" mode to input the coordinates of 

the target ball points recognized, and right-click to set the corresponding world coordinates. 

c. Click the "Apply Station Center" mode to import the point 

coordinates of the station center. 

3. After selecting three or more piercing points, right-click to set world coordinates, and the 

following window will appear. 

 

4. (Optional) Enter world coordinates manually; 

5. Optional: Click Select from point database to set import coordinate projection, then import 

known coordinate data, select target coordinate data, and click OK to complete the world 

coordinate settings. 
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6. Click "Detailed Report" to view the report document and the converted errors. 

7. Click Apply to convert coordinates. 

5.4.5.2. Define Coordinate System 

（1） Functional description ： 

Define projection information for point cloud data, including geographic coordinates (usually 

latitude and longitude) and projection coordinates (planar coordinates converted through 

projection). 

（2） Operating steps ： 

1. Click the Define Coordinate System button to open the following window. 
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2. Select the point cloud input. The file can be a single point cloud data file or multiple data files. 

3. Select a coordinate reference system. You can filter, screen, or import external coordinate 

system files. 

Filtering: Users must input a defined coordinate system. By entering the system's keyword, you can 

filter from the world coordinate system list (e.g., to set the point cloud coordinate system to WGS 

84/UTM Zone 49N, enter UTM 49N in the filter options for quick selection, or use its EPSG code: 

32649 for instant lookup). Alternatively, click the' Add Coordinate System' button to import a 

system externally. 

Create: Users can customize the coordinate system. 
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Import: Users can add coordinate systems from external sources. 

 

4. Click OK to define the coordinate system. 

5.4.5.3. Reproject 

（1） Functional description ： 

The software supports point cloud projection conversion, including mutual conversion between 

geographic coordinate systems and projection coordinate systems. When converting between 
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different geographic coordinate systems, the differences in ellipsoid and reference plane used may 

require ellipsoid-to-ellipsoid conversion. It provides both seven-parameter and four-parameter 

conversion models. Users can input values for X translation, Y translation, Z translation, X-axis 

rotation, Y-axis rotation, Z-axis rotation, and scale factor to perform seven-parameter 

transformation. 

（2） Operating steps ： 

1. Click the Reproject button to open the following window. 

 

2. Select a target point cloud, and the current coordinate system of the target point cloud will be 

displayed in the current file coordinate system. 

3. Select the target coordinate system for conversion. You can use filters or a custom coordinate 

system. Click the Set Parameters button to create four-parameter or seven-parameter systems and 

convert between them. 

 

4. Click OK to reproject. 
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5.4.5.4. Point Cloud Decimation 

(1) Functional description ： 

(2) The point cloud data is processed by sparse processing. 

(3) Operating steps ： 

1. Click the point cloud thinning tool; 

2. Select the target point cloud; 

 

3. Select the sampling type and set the relevant parameters: 

Minimum point spacing (default: 0.0000): Users must set the minimum distance between two 

points to ensure that the spatial 3D minimum distance between any two points in the sampled 

point cloud is not less than this value. The larger the value, the fewer points are retained. 

Sampling rate (default: 99.99%): Users set the percentage of points to retain. In this mode, the 

software randomly retains a specified number of points. Retained points = Total points × Sampling 

rate. The parameter ranges from 0 to 100%. A smaller value means fewer points are retained. 

Octree (default: 21): This mode allows users to select a subdivision level of an octree. At this level, 

the points closest to the center of each octree cell are retained. Range: 1~21. The smaller the 

value, the fewer points are retained. 

4. Set the output path; 
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5. Click Export to export the point cloud after thinning. 

5.4.5.5. Point Cloud Radius Filtering 

（1） Functional description ： 

The point cloud is filtered by radius filtering method. 

principle ： 

For each point in the input point cloud, define a range (a circle with radius r). If no specified point 

value is reached within this range, the data point will be deleted. Repeat this process until the last 

data point, completing the filtering. 

（2） Operating steps ： 

1. Click the point cloud radius filter button; 

2. Select a target point cloud; 

 

3. Set parameters: search radius and number of points within the radius. 

4. Set the output path 

5. Click Export to export the point cloud filtered by radius. 
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5.5. Station Surveying 

 

FIG. 1.61 Station Survey 

5.5.1. Import SLS Data 

1. Functional description ： 

Import the laser scanning data from ground station instruments (folders ending with.sls) into the 

Preprocessing Manager panel. 

 

Figure 2.11 Stationary 3D Laser Scanner Scanning Data File 

2. Operating steps ： 

1) Click the import button with the mouse 

Figure 2.12 Data Import Window 

2) Select a folder to scan and import data (you can also drag multiple folders to load them 

directly) 
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Figure 2.13 Data Import Panel 

 

Figure 2.14 Parameters can be configured for individual measurement stations 

 

Figure 2.15 Import Settings 

Figure 23 allows configuration of station import, including import options and filter settings, 

applicable to individual stations or all stations. 
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After successful import, the corresponding data sub-node will be generated under the ground 

station workspace in the Preprocessing Manager panel. 

 

Figure 2.16 Workspace 

3. Start conversion 

 
Start conversion at Figure 2.17 

 
Figure 2.18 Conversion completed 
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The import of the original data is complete. 

5.5.2. Auto splice 

1. Click to measure the site and automatically stitch it together 

 
Figure 2.21 Click to auto splice 

2. The splicing initialization settings window will pop up. Select the data initialization type and 

measurement range based on actual conditions. Click to process. 

 
Figure 2.22 Splicing Initialization Device Window 

3. Data initialization, waiting for data initialization to complete; 

 
Figure 2.23 Data Initialization 

4. After initialization, the system will automatically splice and wait for completion. 
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Figure 2.24 Automatic Splicing 

5. Auto-splicing is complete. 

 
Figure 2.25 Complete automatic splicing 

6. Station Adjustment. Click Station Adjustment; 
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Figure 2.26 Station Adjustment 

7. View the splice report. Click the report to confirm export success. 

 

Figure 2.27 Click to join reports 
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Figure 2.28 Registration Report 

Auto-splicing ends here. 
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5.5.3. Manual Splicing 

1. Start manual stitching. Click the site map (station measurement toolbar) — select any two 

stations (hold Ctrl) — click the manual connection button in the lower right corner to start manual 

stitching. 

1) Click the site map (site measurement toolbar) 

 
Figure 2.31 Click site map 

2) Select any two stations (hold Ctrl) — click the lower right corner to manually connect 

 

Figure 2.32 Select any two stations (hold Ctrl) — Click in the lower right corner to manually connect 
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3) Start manual stitching 

 
Figure 2.33 Manual Splicing Window 

2. Select point clouds. Choose the corresponding reference point cloud and moving point cloud. 

 
Figure 2.34 Selection of Corresponding Reference Point Cloud and Moving Point Cloud 

3. Move manually. Select different views, movement methods, and splicing refinement options 

to align the survey point cloud in x, y, and z directions. 
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Figure 2.35 Manual Move 

1) Select the side view to align (merge) clouds from different survey stations along the Z-axis. 

Use drag/rotate to move. The middle mouse button (wheel) zooms the view freely. 

 
Figure 2.36: Point cloud Z-axis alignment completed 

2) Select the top view, drag or rotate the point cloud to align it in the x and y directions. When 

using the rotate tool, double-click the left mouse button to change the rotation center. 

 
Figure 2.37 Select Top View, drag the tool 
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Figure 2.38 Double-click the middle mouse button to change the rotation center 

3) Refined stitching. Select data scenarios and stitching refinement methods to complete refined 

stitching. 

 
Figure 2.39 Splicing refinement 

4) Registration accuracy. The average distance is provided for reference only. Click Apply to exit 

manual stitching. 

 
Figure 2.310 Evaluation and Application of Registration Accuracy 

4. Station Adjustment. Click Station Adjustment; 
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FIG. 2.311 Station Adjustment 

5. View the splice report. Click the report to confirm export success. 

 

Figure 2.312 Click to join reports 
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Figure 2.313 Registration Report 

This completes the manual splicing of common operations. 

Cluster Splicing 

1. Initiate manual splicing. Refer to Section 3.5.3, Subsection 1 for detailed steps. 

 

Figure 2.314 Cluster 
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2. Move the "Cluster Splicing" in the drawing tool 

 
Figure 2.315 Check Cluster Splicing 

3. Select the point cloud. The reference point cloud here refers to a station in Cluster 1 (a public 

connection station), and the mobile point cloud needs to be integrated into the Cluster 1 station. 

The connection node is unavailable at this time. 

 

Figure 2.316 Selecting Point Cloud 

4. Check cluster merge 
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Figure 2.317 Check Cluster Splicing 

5. Refer to Section 2.3 for subsequent steps 

This completes the manual splicing. 
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5.5.4. Target-based Splicing 

5.5.4.1. Manual Target-based Splicing 

1. Start point-to-point connection. Click the site map (station measurement toolbar) — select 

any two stations (hold Ctrl) — click the point-to-point connection in the lower right corner to 

initiate the connection. 

1) Click the site map (site measurement toolbar) 

 

Figure 235 Click site map 

2) Select any two stations (hold Ctrl) — click the point pair in the lower right corner to connect 

 
Figure 236: Select any two stations (hold Ctrl) — Click the point pair connection in the lower right 

corner 
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2. Set up the reference station. Select your 3D view. 

 

Figure 237: Setting up the reference station 

3. Select a point cloud; 

 
Figure 238 Select Point Cloud 

4. The piercing point. There are two piercing point methods. Since the demonstration data only 

includes target balls, the target ball must be selected when choosing the piercing point method for 

this demonstration. The operation process for the target point is the same as that for the target 

ball. If the target point is used as the piercing point method, refer to the target ball piercing point 

operation process. 

 

Figure 239 Selection of puncture point method (Note: Standard target ball radius is 72.5 mm) 
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5. Select the Spike Tool. Go to the Station Survey toolbar and click the Spike Tool to activate the 

Spike Tool box. 

 

Figure 240 Select Spike Tool 

6. Activate the activation tool. Select the target ball for selection. 

 
Figure 241 Selection of Stab Point Types 

 

7. Add a target ball. 

1) Create a target ball in the base station window. Find the target ball in the base station 

window (use intensity display for point cloud rendering). Double-click the target ball to generate it. 

You can customize the name, but it is recommended to keep the default. Click Save to extract the 

target ball for the base station. 
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Figure 242 Reference Station Window 

 

Figure 243 Naming and Storage of Target Balls 

  



165 
 

2) Create a target ball in the mobile station window. Find the target ball in the mobile station 

window (use intensity display for point cloud rendering). Double-click the target ball to generate it. 

You can customize the name, but it is recommended to keep the default. Click Save to extract the 

target ball for the mobile station. 

 
Figure 244 Moving Window 

Special note: The target balls selected for both the reference station and mobile station must be 

from the same set. 

8. Apply the target ball. Pay attention to the deviation value. If it is too large, it indicates that the 

target ball selection for the reference station and the mobile station is inaccurate or incorrect. 

Re-select and then fit again. 

 
Figure 245 Application of Target Ball 
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9. Preview. You can view the stitching effect in the preview window. If the effect meets your 

requirements, proceed to the next step. If not, return to the previous step. 

 
Figure 246 Preview Window 

10. Tap the app. 

 

Figure 247 Click to apply 

11. Update the scan. Repeat this operation to complete the station-to-station splicing. 

 
Figure 248 Update Scan 

12. Target connection. Click Target Connection to display a prompt. Click Yes. 
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13. Station Adjustment. After completing the splicing of all target balls, click Station Adjustment. 

 
Figure 249 Station Adjustment 

 

14. View the splice report. Click the report to confirm export success. 

 

Figure 250 Click to join report 
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Figure 251 Registration Report 

Manual target ball assembly is complete. 

5.5.4.2. Automatic Target-based Splicing 

1. Click 'Measure Station' —select 'Automatic Target Ball Recognition' —enter the target ball 

radius (default: 72.5mm) to start automatic target ball recognition. 

 

Figure 252: Automatic Target Ball Recognition by Click 
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Figure 253: Automatic Target Ball Recognition Settings-Target Ball Radius 

 

 

Figure 254: Automatic Target Ball Recognition 

 

Figure 255 Target ball recognition completed 

2. Click 'Measure Station' → Select 'Auto Join' → Choose 'Target Ball Auto Join' → The process is 
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now in progress. 

 

Figure 2-56: Click the target ball for automatic splicing 

 

Figure 257: Automatic Splicing of Target Balls 
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Figure 258: Automatic target ball assembly completed 

3. Click to perform station adjustment. 

 

Figure 259 Click station adjustment 

1) Click the side triangle of the station adjustment to change the control point and the target 

ball coordinates. 

 

Figure 260 Click Control Point Adjustment 
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Figure 261 Input/Change Target Ball or Station Coordinates 

4. Tap the app; 

 

Figure 262: Results of Station Adjustment 

5. View the splice report. Click the report to confirm export success. 
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Figure 263 Click to join report 

 

Figure 264 View registration report 

Automatic target ball recognition and splicing are completed. 

5.5.4.3. Station Adjustment 

As the name suggests, station correction involves manually or through imported coordinates of 

measurement stations or target points to adjust the station location, thereby assisting in stitching 

to improve both the success rate and precision of the stitching process. 
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Figure 265 Station Correction 

5.6. Tunnel 

5.6.1. Tunnel Pretreatment 

5.6.1.1. Import Data 

1. Import collected data; 

    

2. Select analysis application-tunnel-prism orientation for coordinate transformation and 

splicing; 
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If the error in multiple measurements is significant, the planar threshold and radius threshold 

should be increased, along with the maximum station spacing. Based on the current data, we 

need to set the planar threshold and radius threshold to 0.008 and the maximum station 

spacing to 45 for the data to be mapped to the target coordinates. 

 

3. Select "Import Road" to import road files. 
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5.6.1.2. Crop and Denoise 

1. Crop the point cloud to extract the required area. After cropping, import the point cloud. 
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2. When using the filtering function for noise reduction, select the appropriate phase for 

contour lines based on the specific stage. For the tunnel main route, pay attention to its 

vertical and horizontal offset distances. 

 

 

3. data import software for noise removal; 
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5.6.1.3. Overundercut Calculation 

1. Select "Section Design Parameter Settings" to configure section parameters. You can use 

the default values initially and adjust them as needed. 

 

 

2. Select 'Over/Under Excavation Calculation' to generate the report. Ensure you choose 

the correct phase, and for the tunnel main route, pay attention to vertical and horizontal 

offsets. 
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3. If the user has a block template, you can use the block import feature to import it. The 

template format is as follows: 

 

 

Save the block template to a TXT file and click "Import Block" to import it. 

For example, to calculate data at elevation 2.4, use the following parameters. To use other 

elevations, modify the two values in the black box and import them. 
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You can then set the selected preset blocks in the over-excavation and under-excavation 

calculation interface, and choose the required block template. 

 

If the design outline is expanded, select the expansion parameter to set it. 
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5.6.1.4. Point Cloud Comparison Calculation 

1. Select point cloud comparison-Choose two point cloud files to compare, then click 

Calculate (the files must be denoised and cropped data; large files may cause issues) 

 

2. Find the cloud platform files in the project file path 

The output below is the xyz slas xml for the extension/App/Tunnel/Difference 

3. Heat map statistics 

Open the newly generated *.xyz file. You can generate the heat map statistics file required by 

the cloud platform in the same path. 
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The generated SLAS data can be imported into Pro to view thermal map changes in RGB 

mode. 

 

5.6.2. Tunnel Post-treatment 

1. Import point cloud data 

 
Figure 333 Import point cloud data 
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Figure 334: Complete point cloud import 

2. Click Expand Application — Tunnel Post-processing to activate the tunnel post-processing 

function. 

 

Figure 335 Post-processing of the tunnel after startup 

 
Figure 336 Tunnel Post-processing Manager 

3. Import design lines; extract track walls; 
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Figure 337 Import Design Line 

 

Figure 338: Select Matching Design Line 
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Figure 339 Extracting the orbital wall 

 
Figure 340 completes the extraction of the orbital wall 

4. Midline analysis; 

1) Click the centerline analysis to start the tool. Adjust the parameters as needed, then click OK 

to begin the analysis. 

 
Figure 345 initiates midline analysis and sets analysis parameters 
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Figure 346: Midline analysis 

2) Midline analysis report. You can edit the corresponding section at the specified mileage and 

export the analysis report. 

 

Figure 347: Midline Analysis Report 
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Edit section 348 

 

Figure 349 Exporting the Midline Analysis Report 

5. Ellipticity analysis; 

1) Click Ellipticity Analysis to launch the tool. Adjust the parameters as needed, then click OK to 

start the analysis. 
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Figure 350 initiates ellipse analysis and sets analysis parameters 

 

Figure 351 Ellipticity analysis 

2) Ellipticity analysis report. You can edit the corresponding section and export the analysis 

report. 
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Figure 352 Ellipticity Analysis Report 

 
Edit section 353 
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Figure 354 Export Ellipticity Analysis Report 

The tunnel application is now complete. 

5.6.3. Track Orbit Centerline 

1. Import orbit point cloud data. 

 

Figure 320 Import track data 

2. Click Expand Application to identify the track centerline and start the track recognition 

function. 

 

Figure 321: Initiate track recognition function 

3. Enter the corresponding track width. 
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Figure 322 Input track width 

4. Select the track intersection; double-click to end the selection; then select the track 

intersection with a green box and double-click to end; finally click to end the selection. Note: 

Tracks selected with green boxes do not participate in the calculation, while tracks selected with 

white boxes require separate drawing of the centerline. 

 

Figure 323: Track intersection box selection 

5. Add track — Draw track direction 
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Figure 324 Add Track 

 
Figure 325 shows the track direction 

 

6. Draw track — Merge track 

 

Figure 326: Combined track centerline 
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Figure 327 shows the final orbital midline obtained through merging 

7. Import target points, export reports, and export tracks. 

 

Figure 328 Import Target Site 

 

Figure 329 Export Report 
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Figure 330 Export Track Centerline 
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6. Analysis & Application Module 

6.1. Point Cloud Classification 

 

6.1.1. Extract Ground Points With One-Click 

(1) Function Description: An automatic classification algorithm for ground points, which 

categorizes point clouds into ground points and unclassified points, providing a fast method for 

extracting ground points. 

(2) Operating steps ： 

 

1. Click to extract ground points with one click; 

2. Select ground point classification scenarios; 

3. Click OK to complete the ground point output. The result is as follows: 
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6.1.2. Run Macro Command 

(1) Functional description ： 

The software's built-in automatic point cloud classification algorithm can categorize point clouds 

based on different terrains. 

 

Default template explanation 

⚫ Flat Terrain 

a. ByClass (9999;1): Categorize by attribute (initial category 9999-all categories; target category 

1-unclassified points). 
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b. ByLowPoint (1;7;0,6,0.5,5): Low Point Classification (Initial category: 1-Unclassified points; 

Target category: 7-Low points; Search: A set of points, maximum points: 6, height threshold: 0.5m, 

radius: 5m). 

c. ByGround (1;2;1,60,30,6,0.5,1,1,0,0.5): Ground point classification (initial category 

1-unclassified points; target category 2-ground points; scenario: flat terrain, maximum building 

size: 60m, maximum terrain slope: 30°, iteration angle: 6°, iteration distance: 0.5m, ☑ reduce 

iteration angle when side length <1m, ☐ stop triangle construction when side length <0.5m). 

d. ByHeightRange (9999; 2; -0.1, 0.1): Altitude classification (initial category: 9999-all categories; 

target category: 2-ground points; minimum altitude: -0.1 m, maximum altitude: 0.1 m). 

e. ByHeightRange (0,1; 5; 1,100): Ground elevation classification (initial category 0-unclassified 

creation points and 1-unclassified points; target category 5-high vegetation points; minimum 

ground elevation: 1m, maximum ground elevation: 100m). 

 

⚫ Mountainous Terrain  

f. ByClass (9999;1): Categorize by attribute (initial category 9999-all categories; target category 

1-unclassified points). 

g. ByLowPoint (1;7;0,6,0.5,5): Low Point Classification (Initial category: 1-Unclassified points; 

Target category: 7-Low points; Search: A set of points, maximum points: 3, height threshold: 0.5m, 

radius: 5m). 

h. ByLowPoint (1;7;0,6,0.5,5): Low Point Classification (Initial category: 1-Unclassified points; 

Target category: 7-Low points; Search: A set of points, maximum points: 8, height threshold: 0.5m, 

radius: 5m). 

i. ByIsolatedPoint (0,1;7;2,5): Isolated point classification (initial category 0-unclassified created 

point, 1-unclassified point; target category 7-low point; number of neighboring points: 2, search 

radius: 5m). 

j. ByGround (1;2;3,60,85,10,1.2,0,1,1,0.1): Ground point classification (initial category 

1-unclassified points; target category 2-ground points; scenario: mountainous area, maximum 

building size: 60m, maximum terrain slope: 85°, iteration angle: 10°, iteration distance: 1.2m, □ 

reduce iteration angle, when side length <1m, ☑ stop building triangles, when side length <0.1m). 

k. ByHeightRange (9999; 2; -0.1, 0.1): Altitude classification (initial category: 9999-all categories; 

target category: 2-ground points; minimum altitude: -0.1 m, maximum altitude: 0.15 m). 

l. ByHeightRange (0,1; 5; 1,100): Ground elevation classification (initial category 0-unclassified 

creation points and 1-unclassified points; target category 5-high vegetation points; minimum 

ground elevation: 1m, maximum ground elevation: 100m). 

(2) Operating steps ： 

1. Click the macro command and select the point cloud. 

2. Select a macro command template based on the scenario. 

3. Click OK to confirm. 

4. You can also click Template Management to import or add algorithms directly. 
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General description: 

Each line executes a corresponding classification algorithm. The content format indicates the 

algorithm name (algorithm input parameters). When running the macro command, each 

classification algorithm is executed sequentially from top to bottom. 

(1) Algorithm name explanation: 

By Class: by attribute 

ByGround: Ground point classification; 

ByLowPoint: Low Point Classification; 

ByHeightRange: Height range classification; 

ByIsolatedPoint: Isolated point classification; 

By Mid-air Noise: Classification of airborne noise; 

ByBuildings: Building categories; 

(2) Explanation of algorithm input parameters: 

The number before the first ";" indicates the initial category ID (if multiple categories exist, use 

commas to separate them. For example, ID:9999 represents all categories, while other category 

IDs can be viewed and configured in the software's "File->System Settings->Categories" section). 

The number before the second ";" represents the target category ID for classification. 

The number after the second ";" represents other parameters of the classification (specific to each 

algorithm), separated by commas. 

 

The effect is as follows: 
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6.1.3. Automatic Classification 

6.1.3.1. Sort by Attribute 

（1） Functional description ： 

Convert known categories in the target point cloud to other categories. 

（2） Operating steps ： 

 

1. Select the target point cloud in the list. 

2. Set the initial category and select the target category. 

3. Click OK to classify the target point cloud by category. 

6.1.3.2. Low Point Classification 

（1） Functional description ： 
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A low point refers to a situation in point cloud data where a single point or group of points is lower 

than the surrounding points. In real-world terrain, these low points represent noise points below 

the ground. 

The low point classification function compares the elevation of each point or point group with any 

other point within a given two-dimensional radius, identifying and classifying abnormal data points 

that are lower than surrounding points. This function serves as a preprocessing method for point 

cloud data, effectively enhancing the accuracy of subsequent data processing and modeling. 

Principle ： 

a. The two-dimensional grid is established, and the two-dimensional neighborhood points of 

the points to be classified are found in the initial category. 

b. Compare the elevation of a single point or group of points with any other point within a given 

two-dimensional radius. 

c. If the point or point group is significantly lower than any other point and below the height 

threshold, it is classified as the target category; otherwise, it is not classified. 

（2） Operating steps ： 

 

1. Select the target point cloud in the list. 

2. Set the initial category and select the target category. 

3. Set category parameters 

Search: By default, it is a "set of points" defined within a two-dimensional radius. Compare a single 

point or a point set with the surrounding points. 

Maximum points (number): Default is 6. When searching for point groups, it is the maximum 

number of points in a group of low points. The parameter range is 0 to 20. 
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Height threshold (m): The default is 0.5m, the minimum height difference between a single point 

or point group and surrounding points. 

Radius (m): The default value is 5.0 m, which is the search radius in 2D. 

4. Click OK to classify the target point cloud according to the classification parameters. The result is 

shown in the figure. 

 

6.1.3.3. Air Noise Classification 

（1） Functional description ： 

Airborne noise classification employs filtering algorithms to identify outliers and isolated points. 

These anomalies—points in the measurement dataset that are significantly higher or lower than 

the ground surface—often cause algorithmic errors. Isolated point filtering, also known as image 

denoising, removes data points that are substantially higher or lower than surrounding values due 

to factors like bird interference or multipath effects during measurement. 

Principle ： 

m. The input parameters include the number of neighboring points (n) and the multiple of 

standard deviation (meanK). 

n. For each point, search for the number n of adjacent points in the specified neighborhood, 

and calculate the average distance D between the point and its adjacent points. 

o. Calculate the mean (meanD) and standard deviation (S) of the average distance D between all 

points and their adjacent points. 

p. Any point with D exceeding the maximum distance (MaxD = meanD + meanK * S) is flagged as 

noise and removed. 

（2） Operating steps ： 
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1. Select the target point cloud in the list. 

2. Set the initial category and select the target category. 

3. Set category parameters 

Number of neighborhood points (default: 10): The number of points required in the neighborhood 

to calculate the average distance D from each point to the center point and the mean of all D 

values, meanD. 

Standard deviation multiple (default: 5): A factor, meanK, multiplied by the standard deviation of 

meanD. Points whose distance D is greater than meanD + meanK * S are considered noise. The 

smaller this value, the more points are classified as noise. 

4. Click OK to classify the target point cloud according to the classification parameters. The result is 

shown in the figure. 

 

6.1.3.4. Ground Point Classification 

（1） Functional description ： 

Ground point classification is a critical task in point cloud data processing, involving the 
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identification and categorization of ground points within point clouds through algorithms. 

AcuteLas Studio enhances the classic progressive triangulation method, which typically begins by 

selecting low points as seed points, then constructs a triangulation network and progressively adds 

points until all point cloud data is classified. During the iterative process, the algorithm ensures 

effective classification of diverse terrain features (such as flat surfaces or mountainous areas) by 

setting appropriate thresholds and parameters. 

Principle ： 

a. Grid-based point cloud processing. In point cloud data, the first step is to apply a 

two-dimensional grid. For point cloud datasets containing buildings, the grid size should be 

determined based on the maximum building dimensions to ensure coverage of potential building 

areas. For datasets without buildings, the default grid size is typically used. 

b. Identify ground seed points. The process involves extracting ground seed points through 

morphological filtering, where the morphological opening operation first applies erosion followed 

by dilation. By progressively enlarging the filter window size and performing multiple opening 

operations, the system retains terrain relief details while filtering out objects of varying sizes (e.g., 

trees, vehicles, buildings). These ground seed points are typically located on or near the ground 

surface, though they may occasionally contain noise or non-ground points. Further filtering 

removes seed points that do not meet the ground point criteria, ensuring the reliability of 

subsequent classification ground seed points. 

c. Iterative encryption triangulation. The triangulation network is established using ground seed 

points. For each point, its horizontal plane projection is identified within the corresponding 

triangular surface, and the distance from the point to the surface, as well as the angles between 

the point and the three vertices of the triangle, are calculated. If a point satisfies both conditions: 

1) the distance to the triangle is below the iteration distance threshold; 2) all three angles are 

below the iteration angle threshold, the point is classified as a ground point and incorporated into 

the triangulation network. This process is repeated until all points are classified. 

 

（2） Operating steps ： 
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1. Select the target point cloud in the list. 

2. Set the initial category and select the target category. 

3. Set category parameters 

 

Scene: Select different scenes based on the actual terrain type of the point cloud data. Different 

scenes automatically adjust the classification parameters. 

Maximum building size (m): The default is 60m, which is the diagonal length of the largest building 

in the point cloud data. Generally, the default is sufficient. 

Maximum terrain slope (°): The threshold range is 0° to 90°, representing the steepest slope the 

ground can support. The default value varies by scenario. For point cloud data with significant 

terrain undulations, you can manually increase this value. Additionally, the 89° and 90° parameters 

extract more steep terrain points. 

Iteration angle (°): Default is 10°. During progressive triangulation, this is the maximum angle 

between the line connecting each point to the three vertices of a triangle and the triangle itself. 

The value can be increased when the terrain is highly undulating. 

Iteration distance (m): Default is 1.2m. This is the maximum distance from each point to a triangle 

when creating a progressive triangulation network. You can increase this value if the terrain is 

highly undulating. 
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Reduce the iteration angle when the side length is less than (m): The default is 2.0m. If enabled, 

the iteration angle threshold will decrease when all sides of the triangle are shorter than this value. 

Increasing this value will result in sparser ground points. 

Stop building triangles when the side length is less than (m): The default is 0.5m. If enabled, the 

system will stop encrypting the current triangle if all sides are shorter than this value. Increasing 

this value will result in sparser ground points. 

Default value: Click this option to restore all parameters to their default values. 

 

4. Click OK to classify the target point cloud according to the classification parameters. The result is 

shown in the figure. 

 

6.1.3.5. Classification by Ground Clearance 

（1） Functional description ： 

The ground height classification refers to the extraction and classification of points within a certain 

height range from the ground, which can quickly categorize various ground objects based on 

different ground heights, such as thick ground points, lower ground points, and vegetation points, 

using different parameters for extraction. 

Principle ： 

This feature requires ground point classification of the point cloud data. Users specify minimum 

(h_min) and maximum (h_max) ground elevations to define the elevation range. The system 

generates a triangular mesh with predefined grid dimensions, then identifies each point's 

horizontal projection within the corresponding triangle. The projection distance (h) is calculated, 
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and points are classified based on whether their h values fall within the specified range. 

（2） Operating steps ： 

 

1. Select the target point cloud in the list. 

2. Set the initial category and select the target category. 

3. Set category parameters 

Minimum ground clearance: the minimum elevation difference below ground level in the 

unclassified area, which can be negative. 

Maximum ground clearance: The maximum elevation difference above ground level in the 

unclassified area. The parameter can be negative. The minimum ground clearance is less than the 

maximum ground clearance. 

4. Click OK to classify the target point cloud according to the classification parameters. The result is 

shown in the figure. 
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6.1.3.6. Building Classification 

（1） Functional description ： 

Building classification is the classification of building parts in point cloud. 

principle ： 

Before using this feature, the point cloud data must undergo ground point classification. First, 

extract all ground objects above ground points. Then, perform principal component analysis (PCA) 

to extract feature values from each point in the ground object point cloud, analyze local geometric 

characteristics, and filter out points with non-planar features. Next, apply the RANSAC algorithm to 

the filtered point cloud to effectively remove points not belonging to planar structures. Finally, use 

clustering methods to perform geometric prior clustering on the point cloud, ultimately obtaining 

the point set of each individual building. 

 

（2） Operating steps ： 

 

1. Select the target point cloud in the list. 

2. Set the initial category and select the target category. 

3. Set category parameters 

Number of planar points (points): The threshold range is 0-30, with a default value of 15, 

indicating the number of points in the point cloud identified as "planar" by the RANSAC algorithm 

that belong to the specified plane. Reducing this value preserves more final building points but 

introduces additional errors and irregular planes. Increasing this value decreases the number of 

final building points while improving the precision of planar extraction. 
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Neighborhood point set divergence: The threshold range is 0~0.1, with a default value of 0.03, 

indicating the geometric characteristics of local regions in the point cloud. Lower divergence 

values help extract flatter regions. 

Open operation window size: The default value is 3, which is the window size for morphological 

operation filtering. It is mainly used to remove small noise points or isolated regions. The larger 

the value, the stronger the filtering effect. 

Close window size: The default value is 5, which is the window size used for morphological closing 

operations during filtering. It primarily fills small holes, fine cracks, or discontinuous areas in the 

point cloud. The larger the value, the stronger the filtering effect. 

Expansion window size: The default value is 3, which is the window size for morphological 

expansion operations during filtering. The primary purpose is to increase the density of the 

building point cloud and expand existing areas in the point cloud. The larger the value, the 

stronger the filtering effect. 

4. Click OK to classify the target point cloud according to the classification parameters. 

6.1.4. Manual Classification 

 

（1） Functional description ： 

Since automatic classification algorithms rarely achieve 100% accuracy, human-assisted 

classification is often required to meet product specifications. The software provides manual 

classification methods including circular, rectangular, polygon, online/offline, line-in-line, brush, 

and single-point classification. When combined with the sectioning tool, these methods enable 

further refinement of point cloud classification. 

（2） Operation declaration 

1. Click to enable manual classification. Set relevant parameters according to the actual size of the 

measurement area to enter the manual classification interface. 
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2. Select the manual classification method for interactive classification 

3. (Optional) Click to undo all previous manual categorization actions 

4. Click Save to save the manually classified results and directly modify the corresponding source 

file. 

5. Click Exit to exit manual classification mode. 

6.1.4.1. Start Manual Classification 

（1） Functional description ： 

Enter manual interaction classification mode. 

（2） Operation declaration 

1. Click Manual Interaction Classification to enter the manual interaction classification mode. 

2. The manual sorting tool is now available. 

6.1.4.2. Circle Classification 

（1） Functional description ： 

Convert the point cloud in the circular selection to the target category. 

（2） Operation declaration 

1. Click the round category; 

2. Set the initial category and select the target category. 

3. Draw a circular area and classify the target point cloud within it according to the specified 

parameters. The result is shown in the figure. 

 

6.1.4.3. Polygon Classification 

（1） Functional description ： 
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Convert the point cloud in the polygon selection to the target category. 

（2） Operation declaration 

1. Click Polygon Classification; 

2. Set the initial category and select the target category. 

3. Draw a polygonal area and classify the target point cloud within it according to the specified 

parameters. The result is shown in the figure. 

 

6.1.4.4. Rectangle Classification 

（1） Functional description ： 

Convert the point cloud in the rectangular selection to the target category. 

（2） Operation declaration 

1. Click the rectangle category; 

2. Set the initial category and select the target category. 

3. Draw a rectangular area and classify the target point cloud within it according to the specified 

parameters. The result is shown in the figure. 

6.1.4.5. Above Line Classification 

（1） Functional description ： 

Convert the point cloud above the drawing line to the target category. 

（2） Operation declaration 

1. Click online classification; 

2. Set the initial category and select the target category. 

3. Draw a line segment and classify the target point cloud above the line according to the 

classification parameters. The result is shown in the figure. 

6.1.4.6. Below Line Classification 

（1） Functional description ： 

Convert the point cloud in the selected area below the drawing line to the target category. 

（2） Operation declaration 

1. Click offline categories; 
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2. Set the initial category and select the target category. 

3. Draw a line segment and classify the target point cloud below it according to the classification 

parameters. The result is shown in the figure. 

6.1.4.7. Multi-Line Classification 

（1） Functional description ： 

Convert the point cloud above, below, and in the middle of the selected area to the target 

category. 

（2） Operation declaration 

1. Click the category in the line; 

2. Set conversion operations for each direction, including the initial category and target category. 

3. Draw a line segment and classify the target point clouds above, below, and in the middle of the 

line segment according to the classification parameters. The result is shown in the figure. 

6.1.4.8. Brush Classification 

（1） Functional description ： 

Convert the point cloud in the selection to the target category. 

（2） Operation declaration 

1. Click on the brush category; 

2. Set initial and target categories; 

3. Select the point cloud with the brush, then classify the target point cloud in the selected area 

according to the classification parameters. The result is shown in the figure. 

6.1.4.9. Single Point Classification 

（1） Functional description ： 

Convert the selected point cloud to the target category. 

（2） Operation declaration 

1. Click single point classification; 

2. Set initial and target categories; 

3. Select a single point cloud and classify the target point clouds in the selected area according to 

the classification parameters. 
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6.1.4.10. Undo 

（1） Functional description ： 

Undo all manual category edits and revert to the original data. 

（2） Ooperation declaration 

1. Click to undo, which cancels all previous manual categorization actions. 

6.1.4.11. Save 

（1） Functional description ： 

Save manually edited content to the original point cloud file. 

（2） Operation declaration 

1. Click Save to execute the operation and overwrite the source file with all previously manually 

categorized results. 

6.1.4.12. Exit 

（1） Functional description ： 

Exit manual sorting mode. 

（2） Operation declaration 

1. (Optional) Click to exit and leave manual classification mode. 

2. (Optional) If you do not save the results, click Exit to see the prompt "Save manual classification 

results to point cloud?" Select Yes to save the results and exit edit mode, or click No to exit edit 

mode directly. 

6.1.5. Export Category 

（1） Functional description ： 

Export point clouds by specified categories. 

（2） Operation declaration 
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1. Click to export by category. 

2. Select the target point cloud in the list. 

3. Set initial and target categories; 

4. Set export path 

5. Export only point clouds of the specified category. 

6.1.6. Block Processing 

6.1.6.1. Block Tool 

1.Click the block tool; 

2.Set block width, length, and other parameters; 

3.Select an output path; 

4.Click OK to complete the point cloud segmentation. 

 

6.1.6.2. Divide by Centerline 

1. Draw centerline; 
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2. Set block width and length parameters; 

3. Click OK to complete the block step. 

 

6.2. Topography 

 

6.2.1. Build TIN  

（1） Functional description ： 

The irregular triangular mesh model is generated based on point cloud. 

（2） Operating steps ： 

 

1. Select the target point cloud in the list; 
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2. Set initial category; 

3. Check to block and set block parameters (divide evenly by rows and columns); 

4. Set the output path; 

5. Click OK to output the triangular mesh surface model (TIN); 

6. Prompt whether to load to the panel. Click Yes to import the generated stin format into the 

model layer of the drawing panel. 

6.2.2. Contour Generation  

（1） Functional description ： 

The contour file is generated based on point cloud or TIN model data. 

（2） Operating steps ： 

 

1. Select the target point cloud from the list or choose the target TIN model data; 

2. Set the spacing, color, and line width of contour lines; 

3. Set optimization options; 

4. Select the file output format; 

5. Set the output path; 

6. Click OK to export contour data; 
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7. Prompt whether to load to the panel. Click Yes to import the generated contour format into the 

vector layer of the drawing panel. The display effect is shown in the figure. 

 

6.2.3. Generate DSM  

（1） Functional description ： 

DSM files are generated from point clouds, containing elevation data such as topographic tables. 

（2） Operating steps ： 

 

1. Select the target point cloud in the list; 

2. Check the initial category as all categories except low point; 

3. Set resolution parameters (XSize, YSize); set triangle side length limits; 

4. Check to merge output; 

5. Set the output path; 

6. Click OK to export DSM data; 
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7. A prompt appears asking if you want to load the data to the panel. Click Yes to import the 

generated DSM format into the raster layer of the layer panel. The display effect is shown in the 

figure. 

 

6.2.4. Generate DEM  

（1） Functional description ： 

The DEM file is generated based on point cloud or TIN model data. The DEM only contains 

elevation information of terrain, which is generated based on the ground point categories 

completed by classification, and does not contain other surface information. 

（2） Operating steps ： 
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1. Select the target point cloud from the list or choose the target TIN model data; 

2. Set resolution parameters (XSize, YSize); set triangle side length limits; 

3. Check to merge output; 

4. Set the output path; 

5. Click OK to export DEM data; 

6. A prompt appears asking if you want to load the data to the panel. Click Yes to import the 

generated DEM format into the raster layer of the layer panel. The display effect is shown in the 

figure. 

 



219 
 

6.2.5. One-click DEM Generation  

（1） Functional description ： 

Quickly generate a DEM by automatically classifying the point cloud and outputting the DEM when 

the point cloud is unprocessed. 

 

（2） Operating steps ： 

1. Select the target point cloud in the list; 

2. Set resolution parameters (XSize, YSize); set classification scenarios; 

3. Check to merge multiple files; Check to adjust parameters in advanced settings; 

4. Set the output path; 

5. Click OK to export DEM data; 

6. Loading succeeded; 

7. Right-click the model in the Layer Manager to import the newly exported DEM. The effect is as 

follows. 
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6.2.6. Edit DEM  

 

（1）Feature description: Supports elevation adjustment, data smoothing, and efficient 

processing of digital elevation models. 

（2）Steps:  

1. Click the DEM editing tool; 

2. Select the DEM model to edit; 

3. Select a processing method; 

4. Save after adjustment. 
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6.2.7. Edit TIN  

 

（1） Functional description ： 

Select the triangulation model loaded into the layer to enter edit mode. You can add points, delete 

single points or multiple points, draw fault lines, draw closed lake fault lines, draw river fault lines, 

delete fault lines, or undo changes. Finally, click Save to overwrite the original TIN model. 

（2） Operating steps ： 

1. Select a model to edit. 

2. The TIN model can be edited by adding points, deleting single points, deleting multiple points, 

drawing fracture lines, drawing closed lake fracture lines, drawing river fracture lines, deleting 

fracture lines and so on. 

3. (Optional) Click Cancel to undo all previous edits. 

4. Click Save to save the edited model and overwrite the original one. 

6.2.7.1. Start Editing 

（1） Functional description ： 

Select the loaded triangulation model on the layer to edit. 

（2） Operation declaration 

1.Click to start editing; 

2.Select the loaded model data in the layer; 

3.Click OK to enter edit mode and make editing tools available; 

4.(Optional) Click Cancel to skip editing. 

6.2.7.2. Punctuate 

（1） Functional description ： 

Add vertices to the triangulation model. 

（2） Operation declaration 

1. Click to add a dot, and the settings window will pop up. 
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2. Set elevation sources with four options: triangulation surface, maximum surface elevation, 

minimum surface elevation, or user input 

Triangle mesh surface: Determines the elevation of the insertion point using triangular 

interpolation 

Maximum surface elevation: the highest value within the elevation range of this model 

Minimum surface elevation: the lowest elevation within the model range 

User input: Custom elevation value 

3. Click the model where you want to add points. 

4. Successfully added a point to the target location. 

6.2.7.3. Delete Single Point 

（1） Functional description ： 

Delete the specified vertex from the triangulation model. 

（2） Ooperation declaration 

1. Click to delete a single item; 

2. Click the model to delete the point; 

3. Delete the corresponding vertex. The effect is shown in the figure. 

6.2.7.4. Add Multiple Points 

（1） Functional description ： 

Delete vertices from the triangulation model within the polygon drawing range. 

（2） Operation declaration 

1. Click to add multiple points; 

2. Draw a polygon, select the model vertex to delete, and right-click to finish drawing. 

3. Automatically delete the corresponding vertex; 

6.2.7.5. Draw a Dashed Line 

（1） Functional description ： 

The software supports drawing fracture lines to distinguish different land features, providing both 

soft and hard fracture line options. 
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principle ： 

Here is an example of enforcing different surface properties by adding soft fracture lines. Note 

how the TIN builder adds additional nodes along the fracture lines to ensure they remain within 

the TIN. The z values of these new nodes are obtained through linear interpolation along the 

fracture lines. 

       The input data of TIN includes four points and a line with two nodes. 

 
      TIN generated when processing points and nodes as discrete multi-points 

 

      When this line is forced as a broken line, it remains in the TIN. Note the z values of the 

introduced nodes. 

 
     Similar to all fracture lines, the z-value of a soft fracture line can be either constant or 

variable. For example, a pipeline segment with constant elevation can be defined as a soft fracture 

line. Likewise, a road segment with fluctuating elevation can also be incorporated into the TIN 

surface model as a soft fracture line. 

Hard fracture line: Defines a smooth surface discontinuity, the most common type of fracture line. 

It is often used to define the abrupt change in the surface of rivers, ridges, shorelines, or road 

edges. In slopes, it can effectively define the excavation boundary of roads. 

（2） Operation declaration 

1. Click to draw a dashed line, and the following window will appear. 

 

Select line type: Soft fracture line (generate points on the triangulation) 

                  Hard fracture line (generate points on the fracture line) 
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The default starting elevation of a hard fracture line is the surface elevation of the triangle. After 

selecting the manual input elevation, users can customize the starting elevation value. 

2. (Optional) Select hard break lines to draw polylines on the model. Right-click to finish. The result 

is shown in the figure. 

 

3. Optional: Select hard break lines, check to change elevation, set the starting elevation value, 

draw polylines on the model, right-click to end, and the effect is shown in the figure. 

 

4. (Optional) Select to draw a soft break line, draw a polyline on the model, and end with the 

right-click option. The result is shown in the figure. 
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6.2.7.6. Draw a Lake Fault Line 

（1） Functional description ： 

Draw polygons around the lake and generate a surface with a fixed elevation in the polygon area. 

（2） Operation declaration 

1. Click to draw (close) the lake fault line, and the following window will pop up; 

 

2. Set the target elevation; 

3. Draw polygons. Right-click to stop drawing. 

4. Generate a lake fault line, as shown in the image. 

 

6.2.7.7. Draw River Fault Lines 

（1） Functional description ： 

Draw two polylines along the river and generate a surface with specified elevation values in the 

area between the two lines. 
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（2） Operation declaration 

1. Click to draw river fault lines and the following window will pop up. 

 

2. Set the starting elevation of the target; 

3. Draw the first multisegment line along the riverbank, then right-click to finish. 

4. Draw a second multisegment line along the riverbank, then right-click to finish. 

5. (Optional) Click to clear drawings, clearing only the polylines drawn in this view, not the added 

dashed lines. 

6. (Optional) Click Add to generate a river breakline based on the two polylines you draw. The 

result is shown in the figure. (When drawing only one polyline, clicking Add will display a prompt: 

"Draw a second polyline.") 

 

7. (Optional) Click to exit and stop drawing river fault lines. 

6.2.7.8. Delete Dashed Line 

（1） Functional description ： 

Delete the drawn break line. 

（2） Operation declaration 

1. Delete the broken line; 

2. Delete the selected dashed line. 
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6.2.7.9. Recall 

（1） Functional description ： 

Undo all TIN editing operations and revert to the original data. 

（2） Operation declaration 

1. Click to undo, cancel all previous TIN editing operations. 

6.2.7.10. Save 

（1） Functional description ： 

Save the edited content to the original file. 

（2） Operation declaration 

1. Click Save to execute the operation, saving all previous TIN edits and overwriting the source file. 

6.2.7.11. Exit 

（1） Functional description ： 

Exit TIN editing mode. 

（2） Operation declaration 

1. (Optional) Click to exit and leave TIN editing mode. 

2. Optional: If you do not save, click Exit to see the prompt "Save TIN to the project?" and select 

Yes to save the TIN before exiting edit mode. Click No to exit edit mode directly. 

6.2.8. TIN Visualization 

6.2.8.1. Point Mode 

（1） Functional description ： 

The model data in the current window is displayed by vertex status. 

（2） Operation declaration 

1. Click point mode; 

2. The model data in the current window is displayed by vertex, as shown in the figure. 
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6.2.8.2. Face Mode 

（1） Functional description ： 

The model data in the current window is displayed in a planar mode. 

（2） Operation declaration 

1. Click to display the model; 

2. The model data in the current window is displayed according to the model status, as shown in 

the figure. 
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6.2.8.3. Wireframe Mode 

（1） Functional description ： 

The model data of the current window is displayed according to the triangulation network status. 

（2） Operation declaration 

1. Click the line mode; 

2. The model data in the current window is displayed in triangle network format, as shown in the 

figure. 

 

6.2.8.4. Elevation Rendering 

（1） Functional description ： 

The elevation values of the model data are mapped to a specified color range, making it easier to 

observe the elevation changes in the model data. 

（2） Operation declaration 

1. Click to display by elevation 

2. The triangular mesh model is displayed in elevation rendering mode. 
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6.2.8.5. Category Rendering 

（1） Functional description ： 

Map the category information of the model data to a specified color for easy observation of model 

categories. 

（2） Operation declaration 

1. Click to sort by category; 

2. The triangular network model displays information by category. 

 

6.3. Mining 
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6.3.1. Volume Calculation 

 

6.3.2. Projected Volume  

（1）Functional description ： 

Calculate the volume of a specific area or object. 

Principle: The system constructs a 3D model and performs spatial analysis and calculations to 

project objects or areas from three-dimensional space onto a specific plane. The volume is then 

calculated based on the projected area and height information. For instance, when dealing with 

irregular terrain or buildings, the software determines their boundaries and height variations using 

point cloud data, subsequently calculating the corresponding volume. 

（2）Operating steps ： 
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1. Constructing TIN model based on point cloud data; 

2. Click the projection volume, select the TIN model to calculate, and click OK. 

3. Select the benchmark method and click Calculate. 

4. Select a save path for the exported report 

 

6.3.3. Volume Compariso  

(1) Functional description ： 

This method analyzes point cloud data from the same area at different time points to capture 

volume changes in objects or terrain within the region. By comparing the calculated volumes of 

two datasets, it identifies the volume variation. Furthermore, it analyzes the distribution of these 

changes, using contour lines to highlight areas with volume increases or decreases and the 

magnitude of the changes. This provides an intuitive understanding of the dynamic volume 

changes in the same area over time. 

Principle ： 

For the constructed 3D model, its volume is calculated through specific algorithms. The common 

method is based on spatial discretization, dividing the 3D model into multiple small elements, then 

calculating the volume of each element and summing them to obtain the total volume. 

 

(2) Operating steps ： 
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1. The two-phase point cloud data is used to construct the TIN model. 

2. Click on the volume comparison and select the two TIN models to calculate. 

3. Adjust the range line parameters and click Calculate. 

4. After calculation, click to generate the range line. Red indicates positive two-period volume 

deviation, while blue indicates negative two-period volume deviation. 

5. Click to export the report and select a save path. Click to view. 
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6.3.4. Point Cloud Comparison 

(1) Functional description ： 

Analyze and compare different point cloud data to obtain the differences between point clouds. 

The comparison results are visualized in color and contour lines. 

Compare point clouds obtained from different acquisition methods or devices to evaluate data 

collection accuracy and check data quality issues such as noise and erroneous points. Detect 

changes in point clouds within the same area over different periods to identify the extent of 

variation, which is used for monitoring building deformation and terrain evolution. 

(2) Operating steps ： 

 

 

1. Import two datasets and click to compare point clouds. 

2. Adjust parameter values; 

3. Click to calculate and get the heat map. 

4. Click to generate the range line. Red indicates positive deviations between the two periods, 

while blue indicates negative deviations. 

5. Click to export the report, select a path to save and view, and the result is as follows. 
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6.3.5. Deviation Measurement 

(1) Functional description ： 

It is primarily used to evaluate the differences in volume calculation between two or more point 

cloud datasets. This helps identify deviations in the calculated volumes of point cloud data from 

the same area across different periods, thereby analyzing whether the volume changes of objects 

or terrain within the area are within a reasonable range. 

(2) Operating steps ： 

 

 

 

1. After comparing the point clouds, click on the deviation measurement. 

2. Double-click the left key on the thermal map to get the deviation value of the point; 
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3. After selection, you can preview in the selection list. 

4. Click to export the report, select a save path, and view it. 

6.4. Vector 

 

6.4.1. Data Source 

6.4.1.1. New-built 

(1) Functional description ： 

Create a new vector data item or file to start a new vector data processing task. 

(2) Operating steps ： 

 

1. Click New; 

2. Modify the file name and project directory in the pop-up window. 

3. Click OK. 

6.4.1.2. Open 

(1) Functional description ： 

Open the saved vector data file to continue your work or view historical data. 

(2) Operating steps ： 

1. Click to open 

2. Find the.mdb project to operate on. 

3. Click to open. 

 

6.4.1.3. Close 

(1) functional description ： 

Close the current vector data file and end the operation on it. 

(2) operating steps ： 

After vector drawing and operations are completed, click to close this project. 
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6.4.2. Drawing 

6.4.2.1. Draw a Dot 

(1) Functional description ： 

Draw point elements to mark specific locations. 

(2) Operating steps ： 

 

1. Click to draw a dot; 

2. When you left-click a ground feature point on the point cloud, the General Points in the right 

Vector Editor will show the number of points. 

 

6.4.2.2.  Draw Line 

(1) Functional description ： 

Draw a straight line segment to create a vector element for a straight shape. 

(2) Operating steps ： 

 

1. Click the line; 

2. Left-click to draw a line on the point cloud, right-click to select the next action, or click the 

corresponding letter directly. 

3. The number is displayed on the common line of the right vector editor manager. 
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6.4.2.3. Draw Polygon 

(1) Ffunctional description ： 

Draw a polygon to create a surface vector object. 

(2) Operating steps ： 

 

 

1. Tap the image; 

2. Right-click the point cloud to select the next action, or click the corresponding letter directly. 

3. The general surface of the right vector editor manager displays the quantity. 

 

6.4.3. Editing 

6.4.3.1. Add Node 

(1) Functional description ： 

Add a new node to the vector drawing to refine or modify the shape. 

(2) Operating steps ： 

 

1. Click to add a node. Left-click the vector to add a point. 
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2. Move the mouse to the dot and click with the left button 

6.4.3.2. Delete Node 

(1) Functional description ： 

Delete nodes from vector graphics to refine or modify the shape. 

(2) Operating steps ： 

1. Click Delete Node. Left-click the vector to delete the node. 

 

6.4.3.3. Move Node 

(1) Functional description ： 

Move nodes on vector graphics to refine or modify the shape. 

(2) Operating steps ： 

1. Click the moving node and left-click the vector to move it. 

2. Move to the location and end with a left-click 

 

6.4.3.4. Delete 

Select a vector. Click to delete. 

 

6.4.3.5. Shift 

(1) Functional description ： 

moving vector 

(2) Operating steps ： 

1. Select a vector and click to move it. 

2. Click the vector with the left mouse button to move it. 

6.4.3.6. Copy 

(1) Functional description ： 

Copy the selected vector elements to quickly create identical ones. 

(2) Operating steps ： 

1. Click the Select tool to select the vector you want to operate on. 

2. Select the vector, then click Copy, and finally click the vector. 

3. Move the mouse to click and copy multiple items at once. 
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6.4.4. Tools 

6.4.4.1. Undo 

Undo the previous action to correct errors. 

6.4.4.2. Redo 

Restore the undone action. 

6.4.4.3. Select 

Click to select the vector for easy operation. 

6.4.4.4. Snap 

When performing vector drawing or editing operations, the software automatically anchors the 

cursor to specific geometric points, such as endpoints, midpoints, or intersections of drawn vector 

graphics. 

6.4.4.5. Ortho Mode 

When Orthogonal is enabled, the cursor can only move horizontally or vertically when drawing 

vector graphics such as straight lines. 

It helps quickly draw horizontal or vertical lines, making it very useful for drawing regular shapes 

(such as rectangles) or creating vector elements with horizontal and vertical relationships. 

6.4.4.6. Circulating Elevation Display 

(1) Functional description ： 

According to a certain order and rule, the area corresponding to different elevation values is 

presented in a cycle, which is convenient for intuitive viewing of the terrain or the object in 

different height levels, and understanding the continuity and changing trend of elevation 

distribution. 

(2) Operating steps ： 

 

 

Click to display elevation in loop mode 

In the pop-up window, click to select the starting point (optional), then click the ground point. 

Adjust the color band and step size; 

Click OK to apply the effect. 
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6.4.4.7. Cut into Slices 

(1) functional description ： 

Load specific slices as needed, loading only point cloud slices within the current view. 

(2) operating steps ： 

 

1. Click the Slicing tool; 

2. Click to select a slice center, then click a point in the point cloud as the slice center. 

3. Adjust the slide parameters while viewing, based on your needs and the displayed point 

cloud. 

4. After adjustment, the closed point cloud can be automatically recognized by left-clicking and 

selecting. 

5. Click Exit to finish slicing. The result is as follows 
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6.4.5. Data Export  

After vectorization, the files can be exported in DWG, DXF, or SHP formats. 

 

6.5. CBE Calculation 

6.5.1. Menu 

The module now includes "One-Click Ground Point Extraction", "Partial Terrain Generation", 

and "Range Line Drawing" to enable users to perform basic point cloud preprocessing before 

proceeding with volumetric calculations. Key computational features include "Grid Volume", 

"Triangulation Volume", "Model Volume Measurement", "Change Analysis", and "Volume 

Comparison". 
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6.5.2. Function 

6.5.2.1. Draw a Range Line 

Click the "Draw Range Line" function to enter capture mode. Capture the location of features 

in the view to obtain the range line. Mouse operations include: 

⚫ Left mouse click 

⚫ Get coordinates. Click multiple times to connect them into a line. 

⚫ Right-click to reset the current range line. If you click incorrectly, right-click to reset. 

⚫ Double-click with the left mouse button to complete range line capture. The current 

range line will be automatically saved as an SHP file and imported into the project. 

After completing, the mouse remains in capture mode, allowing users to continuously 

capture range lines. To exit capture mode, simply click the 'Draw Range Line' function again. 

 

6.5.2.2. Grid Volume 

When you click the "Grid Volume" function, a dialog box appears. In the "Layer Manager", 

select the data to calculate, and the "Data Name" in the "Current Data" field will update 

accordingly. The current "Grid Volume" supports either multiple point cloud datasets or a 

single DEM model. If you choose to calculate using point cloud data, the grid will be 
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generated based on the specified "Grid Size". If you select DEM model data, the "Grid Size" 

will reflect the grid dimensions of the selected dataset. 

 

 

To calculate the grid volume, use a range line. Select the corresponding range line. 

 

There are three "Baseline Methods": Minimum, Custom Value, and Custom Plane. 

 

Both minimum and custom planes use the elevation plane as the reference plane. The custom 

plane is manually selected. After selecting "Custom Plane", three consecutive clicks on the 

point cloud will automatically calculate a plane using these points and display the normal of 

the current custom plane. To redefine the plane, select the "Reset Plane" button before 

"Custom Plane" to restart the definition. 
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After confirming the calculation parameters, click "Calculate". The results will be displayed in 

"Pile Information" and "Calculation Results". "Pile Information" indicates the inherent 

properties of the data within the current range line, while "Calculation Results" shows the fill 

and excavation results compared to the reference plane. 

The system automatically generates DXF files containing grid results during computation. 

When the grid count within the range exceeds 300,000, it will alert users of excessive data 

volume. 

The Export Report feature exports the current calculation parameters and results to a PDF file, 

and saves the DXF file as a separate file in the target folder. 

6.5.2.3. Triangulation Volume 

Clicking the "Triangulation Volume" function opens a dialog box. In the "Layer Manager", 

select the data to calculate, and the "Data Name" in "Current Data" will display synchronously. 

The current "Triangulation Volume" supports multiple point cloud datasets or a single tin 

model dataset. 
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The "triangulation volume" calculation range line is optional. If you use it, check the range line 

and select the corresponding range line. 

 

The "baseline method" is consistent with the "baseline method" in "Grid Volume". 

After confirming the calculation parameters, click "Calculate". The results will be displayed in 

"Pile Information" and "Calculation Results". "Pile Information" indicates the inherent 

properties of the data within the current range line, while "Calculation Results" shows the fill 

and excavation results compared to the reference plane. 

The Export Report feature exports the current calculation parameters and results to a PDF 

file. 

6.5.2.4. Model Volume Measurement 

Consistent with the original function. 

6.5.2.5. Change Analysis 

When you click the 'Change Analysis' feature, a dialog box appears, and the view displays a 

'Deviation Measurement' menu bar alongside the 'Layer Manager', with a 'Comparison 

Results' sidebar added below. 

Select the first-phase and second-phase data to calculate. If the desired data is not displayed, 

it means it has not loaded into the view. You must first display and load the data. The current 

first-phase data supports single point cloud, DEM, or TIN model data, while the second-phase 

data only supports single point cloud data. 

 

In "Calculate Parameters", "Number of Domain Points" refers to the number of reference 

points in the neighborhood when generating normals from point cloud data. More reference 

points result in smoother normals but slower efficiency. The default parameters are usually 

sufficient. Since DEM and TIN models already contain surface data, this parameter is 

unnecessary. 

The Heatmap Parameters include 5 parameters: 
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⚫ Color bar: Currently supports 2 color bars. The default range is blue to red. When the 

deviation is 0, the color is green or white. 

 

⚫ Minimum deviation (m): Enables when checked. The color band's minimum value is the 

set value. Deviations smaller than the set value are colored as the minimum value. If not 

checked, the current calculation's minimum deviation is used. 

⚫ Maximum deviation (m): If selected, the color band's maximum value is the set value. 

Deviations exceeding this value are colored as the maximum value. If not selected, the 

current maximum deviation value is used. 

⚫ Tolerance threshold (m): The tolerance threshold is the acceptable deviation value. 

When selected, the absolute value of the deviation is set to the same color as zero deviation 

if it is less than the tolerance threshold. 

⚫ Gradient (m): Activates when checked. After setting the gradient, the gradient color 

band will divide colors according to the gradient, replacing the gradient color to make the 

color distinction between different values more obvious. 

The figure below shows a color band with a tolerance threshold of 4 meters and a gradient of 

2 meters. 

The "Change Borderline Parameters" section contains 3 parameters: 

⚫ Deviation threshold (m): Similar to the tolerance threshold in the heat map parameter, 

this value determines when the absolute deviation exceeds it, triggering boundary line 

updates. 

⚫ Neighborhood radius (m): Used with neighborhood points. Search for points within the 

specified number of neighbors, and include only those points whose distance is less than the 

neighborhood radius. 

⚫ Number of neighbor points (points): Used with the neighbor radius to search for points 

within the radius. Points whose distance is less than the radius are included in the statistics. 

 

There are 4 operation buttons: 

⚫ Calculate: Perform calculations using the current "Calculation Parameters" and 

"Heatmap Parameters" and generate a heatmap automatically. 

⚫ Generate Heatmap: Create a heatmap using the current "Heatmap Parameters" and the 

latest calculation result. You can adjust the heatmap style multiple times without 

recalculating. 
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⚫ Change boundary: Generate a change boundary using the current change boundary 

parameters and the most recent calculation result. 

⚫ Export report: Export the report to a PDF file with the latest calculation result. 

 

Comparison result: The generated heat map and change boundary line can be cleared or 

deleted by right-clicking. 

 

Deviation Measurement: Select 'Deviation Measurement' from the View menu bar, then 

double-click the heatmap to measure deviations. The results will appear in the 'Selected 

Points List' and can be exported as a PDF file. 

 

6.5.2.6. Volume Comparison 

Click the "Volume Comparison" feature to open the dialog box, and a "Comparison Results" 

sidebar will appear below the "Layers Manager". 

Select the first-phase and second-phase data to calculate from the "First-phase Data" and 

"Second-phase Data" sections. If the desired data is not displayed, it means the data has not 

loaded into the view. You need to display and load the data first. The current "First-phase 

Data" and "Second-phase Data" support single DEM or TIN model data. 

The DEM model can be calculated using range lines, but the TIN model is not supported. 

After clicking 'Calculate', the comparison results of the two-period model will appear in 

'Calculation Results'. Click 'Export Report' to save the current data to a PDF file. 
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Change the boundary line as above. 

 

6.6. Power Line Survey 

The AcuteLas Studio power survey module integrates field-collected LiDAR point clouds with 

preset parameters, enabling one-click extraction of survey data. Its dual-window interface 

supports real-time mapping of crossing features while generating power design-format output files, 

achieving seamless integration between fieldwork and office processing. 

6.6.1. Menu 

 

6.6.2. Function 

6.6.2.1. Data Source 

 

Set the corresponding voltage level, cross arm width, expansion width due to wind deviation , and 

safety distance width based on the actual site conditions; select the design document for loading; 

adjust the opacity of the coverage area. 
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6.6.2.2. Tools 

(1) Block Tool 

Block the point cloud 

 

Set the parameters as follows: 

a. Width: Set the width for cropping a single point cloud. 

b. Length: Set the length for cropping a single point cloud. 

c. Buffer: Set the overlap length between blocks and point clouds 

d. Export format: Choose *.slas or *.las format 

(2) Divide by Centralline 

Crop the point cloud along the central line 

 

Function operations and parameter settings are as follows: 

Draw central line: Click the "Draw central line" function, then left-click to draw the central line in 
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the point cloud and right-click to finish. 

a. Select vector line: Choose loaded vector lines as center lines for point cloud segmentation. 

b. Central line: Shows the length of the central line. 

c. Width: Set the width for cropping a single point cloud. 

d. Length: Set the length for cropping a single point cloud. 

e. Buffer: Set the overlap length between blocks and point clouds 

f. Export format: Choose *.slas or *.las format 

(3) Resample 

1) Function Description 

         The point cloud data is processed by sparse processing. 

 

2) Operating steps 

a. Select a target point cloud; 

b. Select a sampling type and set the relevant parameters: 

⚫ Minimum pointspacing sampling (default: 0.0000): Users must set the minimum 

distance between two points to ensure that the spatial 3D minimum distance between any two 

points in the sampled point cloud is not less than this value. The larger the value, the fewer points 

are retained. 

⚫ Sampling rate sampling (default: 99.99%): Users can set the percentage of points to 

retain. In this mode, the software randomly retains a specified number of points. Retained points = 

Total points × Sampling rate. The parameter ranges from 0 to 100%. A smaller value means fewer 

points are retained. 
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⚫ Octree sampling(default: 21): This mode allows users to select a subdivision level of an 

octree. At this level, the closest point to the center of each octree cell is retained. Range: 1~21. 

The smaller the value, the fewer points are retained. 

c. Set the output path 

d. Click Export to export the diluted point cloud. You can export *.slas or *.las; 

6.6.2.3. Relative Height Display 

1）Functional description 

The point cloud of power facilities is highlighted; 

2) Operation Steps 

a. Initialise 

Select the corresponding point cloud and click “Confirm”to execute the initialization command 

 
b.Relative elevation display 

Click "Display by relative height" to select different color bands, then click "OK". 

 

6.6.2.4. Automatic Classification 

1) Function Description 

First, the marker tower positions are marked, then the point cloud is automatically classified into 

various ground object categories, such as ground points, vegetation points, buildings, transmission 

towers, and power lines. 
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2) Operation Steps 

a. Marking the tower 

 

Click "Marking Tower" to access the left-side function panel. Select "Add Tower" to choose tower 

locations in the point cloud. After marking, select the tower type from "Unknown Type", "Tension 

Tower", or "Straight Tower". Once all towers in the survey area are marked, click "Applycation". For 

incorrect tower markings, select the target tower and click "Delete Tower" to remove it, or save 

the marked positions separately. 

 

b、 Classify 

Click "Classify" to select the point cloud to classify and set the classification parameters: 
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⚫ Maximum building size (m): The default is 60m, which is the diagonal length of the largest 

building in the point cloud data. Generally, the default is sufficient. 

⚫ Maximum terrain slope (°): The threshold range is 0° to 90°, representing the steepest slope 

the ground can support. The default value varies by scenario. If the point cloud data contains 

significant terrain undulations, you can manually increase this value. Additionally, the 89° and 90° 

parameters extract more steep terrain points. 

⚫ lterative perspective (°): Default is 7°. During progressive triangulation, this is the maximum 

angle between the line connecting each point to the three vertices of a triangle and the triangle 

itself. The value can be increased when the terrain is highly undulating. 

⚫ Iteration distance (m): Default is 0.7m. This is the maximum distance from each point to a 

triangle when creating a progressive triangulation network. The value can be increased if the 

terrain is highly undulating. 

⚫ Minimum ground clearance: the minimum elevation difference below ground level in the 

unclassified area, which can be negative. 

⚫ Maximum ground clearance: The maximum elevation difference above ground level in the 
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unclassified area. The parameter can be negative. The minimum ground clearance is less than the 

maximum ground clearance. 

⚫ Building classification threshold: Default is 1.2 (range 0-4.0). The higher the threshold, the 

fewer building points and the more accurate the result. 

⚫ Vegetation classification threshold: Default is 1.2 (range 0-4.0). The smaller the threshold, the 

fewer vegetation points and the more accurate the classification. 

6.6.2.5. Manual Classification 

1) Function Description 

Since automatic classification algorithms rarely achieve 100% accuracy, human-assisted 

classification is often required to meet product specifications. The software provides manual 

classification methods including circular, rectangular, polygon, online/offline, line-in-line, brush, 

and single-point categories. When combined with the sectioning tool, these methods enable 

further refinement of point cloud classification. 

2) Operation Steps 

a. Click "Classify" to set the block method and block length, width, and buffer. Click "OK" to 

enter the manual category interface. 

 

b. Select the manual classification method for interactive classification 

 

c. (Optional) Click to undo all previous manual classification actions 

d. Click Save to save the manually classified results and directly modify the corresponding 

source file. 

e. Click Exit to exit manual classification mode. 
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For specific manual classification procedures, refer to Section 6.1.4. 

6.6.2.6. Surveying Tools 

(1) Extract Ground Points 

1) Function Description 

Extract the ground elevation points below the design line. 

2) Operation Steps 

Click "Extract Ground Points" to configure parameters in the command window. After completing 

the settings, click "Calculate" to execute the command. 

 

a. Current design line: Select the design line of the ground point to extract. 

b. Extract interval: The step size for sampling elevation points within the "Extraction width" 

range. 

c. Search radius: The radius of a circular area extending outward from the current calculation 

point when extracting ground points. 

d. Gradient variation: the non-maximum suppression radius, which is the point with the 

maximum gradient variation value within the search radius 

(2) Extracting the High Point 

1) Function Description 

Extract the highest point of the design line crossing the ground objects. 

2) Operation Steps 

Click to extract the high point, set parameters in the command window that appears, and click 

"Calculate" to execute the command. 
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a. Cross arm width: Set the width of the tower crossarm; 

b. Extract width: This refers to the horizontal distance range extending outward from the tower 

center. Within this range, the software automatically searches for and extracts the highest point of 

the terrain. 

c. Extract interval: The step size for sampling elevation points within the "Extract width" range 

(3) Extracting wind Deflection Points 

1) Function Description 

Wind deflection data is extracted from the design line. 

2) Operation Steps 

Click "Extract Wind Deflection Point", set parameters in the command window that pops up, and 

click "Calculate" to execute the command after completion. 

 

a. Cross arm width: Set the crossarm width of the tower; 

b. Wind deflection width: The maximum horizontal displacement of the side conductor caused 

by wind force under the maximum design wind speed. 

c. Extract width: The total width of terrain points searched from the centerline of the route to 

both sides in 3D terrain or point cloud data. 

d. Extract interval: The distance between two adjacent wind deflection points along the route 

direction. 

(4) Collection 

1) Function Description 
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The map of crossing terrain is drawn by the linkage of point cloud and image. 

2) Operation Steps 

a. Load the image data and activate the 'Collect' command. Click the 'Collect' command to open 

the dual-window interface. In the right-hand 'Power Survey Manager' command panel, search for 

the name of the cross-domain feature you want to draw. Left-click to select the feature, then start 

drawing on the image with the left mouse button and stop drawing with the right mouse button. 

 

 

b. Click the 'Section' function to open '3D View—Section', where you can draw cross-sections 

spanning tree heights and power lines. 
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c. After completing the drawing, click the "Exit" button to stop the drawing. 

6.6.2.7. Data 

(1) Export DHD 

1) Function Description 

Export Results 

 

2) Operation Steps 

a. Click "Export DHD", select the method for exporting tree height, then click "OK" 

 

⚫ Current height: The actual measured height 

⚫ Natural height: Users can predict the starting height based on the tree's growth ratio. 

b. In the pop-up interface, you can edit the pile number and mileage again. After editing, select 

'Output Results', set the storage path, and save the *.org Daoheng data file. b. In the pop-up 

interface, you can edit the pile number and mileage again. After editing, select 'Output Results', 

set the storage path, and save the *.org Daoheng data file. 

 


